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ABSTRACT 

Gliomas are brain tumors that primarily arise from glial cells. Gliomas account 

for 70% of the brain tumors and they are more prevalent in older adults. About 60% of 

the people with gliomas experience at least one seizure. Brain tumors can grow and 

metastasize to neighboring areas, thereby destroying normal brain cells. In a brain tumor 

microenvironment, both malignant cancer cells and healthy brain cells are present. 

Studies have shown that astrocytes may have a role in tumor growth in the brain. 

Monocultures cannot evaluate interactions between two cell types and does not 

accurately represent in vivo conditions. Thus, a co-culture in vitro cell model is needed to 

gain better insight into the dynamics of the system. However, co-cultures are challenging 

as the two different cell types have different growth rates and the population ratios must 

be optimized to achieve a stable system. A co-culture experimental model comprised of 

normal brain cells and cancer cells will be beneficial as it mimics the brain tumor 

microenvironment. In this work, a mixed co-culture method was employed to simulate a 

diseased state of the brain and study cell-cell interactions between normal brain 

astrocytes and glioma cells. In addition, tumor invasion in the presence of normal brain 

cells was studied. This research enhances understanding on the brain tumor 

microenvironment and cancer progression. Signaling molecules such as neurotransmitter 

will be considered in this system, one of these, glutamate, is a major excitatory 

neurotransmitter and plays a major role in normal functioning of the brain. However, 



iv 

excess glutamate is present in numerous neurological disorders such as seizure, and 

epilepsy. Moreover, few studies have examined the uptake of glutamate in co-culture of 

glioma cells and normal brain astrocytes. In the present study, glutamate uptake was 

measured in normal brain astrocytes, glioma cells and combination of both cell types 

using a quantitative colorimetric assay kit. Results showed that co-culture of glioma cells 

with astrocytes enhanced the uptake of glutamate by astrocytes as compared with uptake 

by astrocytes alone. Furthermore, changes in morphology in normal brain cells were 

observed in sodium-free medium when sodium-dependent transporters were blocked. 

New approaches were developed to modify brain cell microenvironment using 

engineered micro/nano materials and chemical treatments such as staurosporine. Finally, 

the potential applications of Copper-containing High Aspect Ratio Structures (CuHARS), 

a promising novel biomaterial, were explored for biomedical purposes such as 

incorporating them with cellulose to construct a stable matrix for CuHARS delivery in 

glioma cells. In addition, interaction of sonicated CuHARS was investigated in a co-

culture model developed earlier in this project and degradation of the sonicated CuHARS 

was studied to quantify degradable biomaterials. 
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CHAPTER 1 

 

INTRODUCTION 
 

1.1 Motivation 

Brain tumors account for almost 90% of all central nervous system (CNS) tumors. 

Brain tumors are different from other tumors because they rarely spread to distant organs. 

However, they can also grow and metastasize to neighboring areas, thereby destroying 

normal brain cells. The brain tumor microenvironment consists of a network of various 

cell types such as microglia, endothelial cells, cancer cells, and astrocytes [1]–[3]. Figure 

1.1 shows the schematic representation of some major cell types that comprises tumor 

microenvironment in the brain. 

Co-culture systems are widely used to study cell-cell interaction between two, or 

more populations of cells. Hurst et al. [4] co-cultured immortalized vascular endothelial 

and C6 glioma cells to study cell-cell interactions and found that endothelial cells 

exhibited changes in morphology that occurred only in the presence of glioma cells. The 

advantage of co-culture systems is that they mimic the in vivo models, however, it is 

complicated to achieve a stable system because of the varying growth rate of the different 

populations of cells. Additionally, two populations of a co-culture system form a co-

operative relationship whereas more than two populations may be challenging [5].  

Gliomas are the most aggressive primary tumors in the brain. Astrocytes, star-

shaped normal glial cells in the brain, play a major role in tumor pathogenesis. Gliomas 
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are the result of malignant transformation of astrocytes [6]. During a diseased state of the 

brain such as cancer, both cancer cells and healthy brain cells such as astrocytes are 

present. In a brain tumor microenvironment, malignant cancer cells and astrocytes 

communicate with each other through gap junction [2]. Studies have shown that 

astrocytes themselves may become transformed into various types of brain tumors, 

including gliomas [7]. 

 

 

 

Figure 1.1: Schematic diagram of some major cell types that comprises tumor 

microenvironment in the brain [8]. 

 

 

 

In this research, a mixed co-culture experimental setup comprised of glioma cells 

and normal brain astrocytes was created to mimic a brain tumor microenvironment. This 

experimental model will provide an excellent platform to understand the interaction 

between two heterogeneous population of cells. Moreover, this co-culture experimental 
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model will expand our knowledge in studying the dynamic relationship between glioma 

cells and normal brain astrocytes. It will further elucidate mechanisms that lead to glioma 

proliferation in a brain tumor microenvironment. However, because the two cell types 

grow at different rates, the cell microenvironment must be set up with different ratios of 

cells for a stable co-culture system. Additionally, whereas a stain for Glial Fibrillary 

Acidic Protein (GFAP) can be used to visualize glial cells in a single cell system, further 

staining is needed in a co-culture model because GFAP is expressed by numerous cell 

types in the CNS, including astrocytes and glioma cells [9], [10]. Thus, another staining 

called β-galactosidase (β-gal) will be employed, in addition to GFAP stain to distinguish 

between the normal brain cells and brain tumor cells. β-gal, which is widely used to 

demonstrate specific gene expression, stains only the glioma cells in our model [11]. 

Further, possibility to identify cell types according to the size of the nuclei will be 

considered in a co-culture experimental model.  

Glutamate is a major excitatory neurotransmitter in the brain. Jacobs et al. [7] 

showed that astrocytes have increased glutamate uptake in comparison to glioma cells 

whereas glioma cells release glutamate, thus promoting the growth of glioma [12]. 

Prakash et al. [13] have reported that epileptic seizures are prevalent among patients with 

glial tumors. However, little has been explored in studying the uptake of glutamate in co-

culture of glioma cells and normal brain astrocytes. Glutamate uptake studies in co-

culture are important to understand how glutamate is regulated in the brain during 

diseased state. Thus, glutamate uptake will be analyzed in the co-culture experimental 

model using a quantitative colorimetric detection kit.     
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1.2 Objectives 

In a diseased state of the brain such as cancer, the behavior of the cells is 

modified by the interaction between healthy and normal cells (i.e. between tumor cells 

and normal brain astrocytes). The objective of this research is to create a mixed co-

culture of normal brain astrocytes and brain tumor cells to mimic brain tumor 

microenvironment and study cell-cell interactions. This will further reveal the 

mechanisms of tumor invasion in a co-culture model and elucidate tumor progression. 

Glutamate must be present in the right concentrations, in the right places, for the right 

amount of time in the brain. Glutamate can be toxic if its concentration is too high in the 

brain. Next, glutamate uptake will be studied in individual as well as mixed cultures. 

Morphology of astrocytes were observed by blocking the sodium-dependent transporters 

which are responsible for glutamate uptake from the extracellular environment. 

Additionally, brain cell microenvironment was modified using different engineered 

micro/nanomaterials. This will help answer questions such as how glutamate is regulated 

in the brain and give us ideas to generate and modify brain cell microenvironment. 

Furthermore, potential applications of a novel biohybrid material CuHARS will be 

explored and degradation of sonicated CuHARS will be investigated. The following 

experiments were developed to test the following hypotheses: 

Hypothesis 1 

A mixed co-culture experimental model is useful to study the interactions between 

normal brain astrocytes and glioma cells. We further hypothesize that tumor cells invade 

the surrounding area in a co-culture experimental model. 

Hypothesis 2 
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A co-culture experimental model is used to study glutamate uptake in a brain tumor 

microenvironment. Furthermore, the presence of glioma cells will affect the rate of 

uptake of glutamate by normal astrocytes. 

Hypothesis 3 

Engineered micro/nanomaterials can be used to modify brain cell microenvironments. 

This modification will result in apoptosis or necrosis of the cells (altered growth). 

Hypothesis 4 

CuHARS can be incorporated with cellulose to a construct stable matrix for delivery to 

cells. 

1.3 Dissertation Overview 

Chapter 1 provides the motivation, objectives for the project, and an overview of 

the dissertation. Chapter 2 provides background and literature review on relevant research 

work involving a major excitatory neurotransmitter, glutamate, glutamate transporters, 

the glutamate-glutamine cycle, and in vitro co-culture methods. Chapter 3 describes 

development of a mixed co-culture model consisting of glioma cells and astrocytes to 

engineer the tumor microenvironment and study whether glioma cells manipulate 

astrocytes to increase their invasiveness. Chapter 4 outlines glutamate uptake in normal 

brain astrocytes and glioma cells (CRL-2303) individually as well as in a co-culture 

model. Chapter 5 talks about new approaches to modify brain cells using engineered 

nanomaterials to regulate glutamate in the brain. Chapter 6 portrays the potential 

applications of a novel biohybrid material named as CuHARS such as its incorporation to 

a non-degradable material for drug delivery and degradation of sonicated CuHARS in a 

co-culture model.
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CHAPTER 2 

 

BACKGROUND AND LITERATURE REVIEW 
 

2.1 Gliomas 

Gliomas are brain tumors that originate from glial cells, the most abundant cell 

types in the central nervous system (CNS). Gliomas account for 70% of the brain tumors 

and are the most common and aggressive primary tumors often diagnosed in older adults 

[14]. 

Gliomas can be low grade (slow growing) or high grade (fast growing). The 

symptoms of glioma are headaches, seizures, problems with speech, memory loss, 

physical weakness, and personality changes among others. The treatment for a glioma 

depends on its grade and may include surgery, radiation therapy, or chemotherapy.  

CNS tumors are classified into Grades I through IV [15]: 

Grade I tumors are also called Pilocytic Astrocytoma. They are slow growing and 

benign tumors. They are more common in children than adults. They occur in the 

cerebellum or brain stem, and sometimes in the cerebral hemispheres. Most are highly 

treatable and curable. 
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Grade II tumors are also known as Low-grade Astrocytoma and are slow. They 

rarely spread to other parts of the CNS. Grade II gliomas are most common in young 

adults aged between 20 to 50. They can either be benign or malignant. 

Grades III are also known as Anaplastic Astrocytoma. These tumors grow faster 

and are more aggressive than Grade II Astrocytomas and can invade neighboring tissue. 

They are more common in men than women.  

Grade IV tumors are also called Glioblastoma Multiforme (GBM). They are the 

most common primary brain tumor. GBM usually spreads quickly and invades other parts 

of the brain. They are most common in older people and less common in children and can 

recur after initial treatment. GBM is the most lethal form of brain cancer. 

2.2 Astrocytes 

Astrocytes are the most abundant glial cells in the CNS [10], [16], [17]. The 

astrocytes resembles a star, hence they are also known as star-shaped cells [18]. They 

perform numerous functions in the brain including removal of glutamate from the 

extracellular compartment, metabolic support, free radical scavenging, water transport, 

and maintaining homeostasis [17], [19]. Two basic types of astrocytes exist, fibrous (in 

white matter) and protoplasmic (in grey matter), as shown in Figure 2.1 [20], [21]. The 

two types of astrocytes differ in the density, length, and surface area of their processes. 
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Figure 2.1: Major types of astrocytes 

 

 

2.3 Cells 

2.3.1 CRL-2303 Glioma Cell Line 

The CRL-2303 (C6/lacZ7) cell line is derived from the C6 cell line (N-

nitrosomethylurea induced glial rat). The cell line expresses the lacZ gene: E. coli derived 

beta-galactosidase. The glioma cell line produces beta-galactosidase (β-gal), and when 

treated with an organic compound called X-Gal, produces an insoluble blue product 

called 5,5'-dibromo-4,4'-dichloro-indigo and stains the glioma cells indigo blue color. 

This characteristic allows the cells to be visualized once they are stained and facilitate 

image analysis by differentiating the glioma cells from normal brain astrocytes in co-

culture studies [22]. They are a naturally adherent cell line with a fibroblast like 

morphology. Figure 2.2 shows images of CRL-2303 cell line in vitro. Figure 2.2 (a) 

shows CRL-2303 cell line pre X-gal treatment, and Figure 2.2 (b) shows the same cells 

post X-gal treatment, with indigo blue staining. 

 



9 

 

 

Figure 2.2: Phase contrast microscopy of CRL-2303 glioma cell line a) Pre X-gal 

treatment b) Post X-gal treatment. Scale bar = 100 um. 

 

 

 

2.3.2 Rat Astrocytes 

Rat astrocytes can be derived from primary, newborn rat (Sprague/Dawley) brain 

cortices. They have broad flat morphology and they are adherent cells. They express glial 

fibrillary acidic protein (GFAP), an intermediate filament protein that is specific to 

astrocytes in the nervous system [23]. Figure 2.3 shows representative images of the rat 

astrocytes in vitro. Figure 2.3 (a) shows normal astrocytes, and Figure 2.3 (b) shows the 

same cells, stained for GFAP. Negative controls for specificity of staining will be shown 

later in this dissertation. 
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Figure 2.3: Rat Astrocytes a) Phase contrast microscopy before GFAP staining b) 

Fluorescence microscopy after GFAP staining. Scale bar = 100 um. 

 

 

2.4 Co-culture 

Co-culture is a technique to grow two or more distinct cell types in a culture dish 

[24] with some degree of contact between them. Co-culture approaches provide an 

excellent model for studying cellular interactions between two or more different 

populations of cells. Some cell types may act differently when cultured in a different 

environment as opposed to their original growth condition [25]–[27]. A single cell type 

may not accurately represent the physiological relevance in in vivo studies especially in 

the brain [5], therefore a mixture of cells will allow for studying heterotypic cell-cell 

interactions. Moreover, in some cases, the presence of more than one type of cell might 

improve the cultivation as they exhibit in vivo physiological behavior [28]–[30]. Hence, a 

co-culture set-up is beneficial for studying cell-cell interactions, and engineering complex 

systems composed of multiple cell types. For example, immortalized human umbilical 

vein endothelial cells (HUVEC-304) when co-cultured with rat C6 glioma cells creates a 

barrier very similar to blood-brain barrier that is not generated in the absence of glioma 

cells [4]. However, creation of a co-culture experimental model can be complicated with 
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each cell type behaving in a specific manner with different growth rates. Usually, co-

culture set-ups with two cell populations are predictable and form a stable system 

whereas more than two cell populations tend to lead to a more chaotic cell growth [31]. 

For example, Hatherell et al. [32] carried out a three-dimensional mono-, bi- and tri-

culture models of the blood-brain barrier and concluded that a bi-cultivation model was 

the most successful among all. Another important factor to be considered for co-culture 

model is the selection of a growth media that best suits all the types of cells [5], [33]. 

Depending on the ultimate application of co-culture, the experimental set-up for a 

two-dimensional in vitro co-culture model can be divided into two modes as shown in 

Figure 2.4; 

1) with cell-cell contact; where the population of cells are mixed 

2) without cell-cell contact; where the populations of cells are partially separated 
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Figure 2.4: Schematic of a two-dimensional in vitro co-culture systems to evaluate cell-

cell interactions a) Mixed co-culture; b) Micropatterning; c) Temporary divider; d) 

Segregated co-culture; e) Conditioned media; f) Porous membrane [34]. 

 

 

 

2.4.1 Cultures with Cell-cell Contact 

2.4.1.1 Mixed co-culture 

In a mixed co-culture (Figure 2.4 a), at least two equal or different population of 

cells of interest are kept together such that they are in contact with each other forming a 

monolayer of cells. Mixed co-culture is one of the simplest co-culture methods where the 

cell suspensions of the cell populations of interest are combined at the desired co-culture 

ratio. The seeding densities of each cell population can be adjusted accordingly [34]. One 

type of cell population can be seeded directly with the monolayer of another cell 

population. If the two cell populations are similar, supplementary growth factors can be 
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used. However, in case of two distinct cell populations, the selection of appropriate 

growth media is required. Guguen-Guillouzo et al. [35] showed that the mixed co-culture 

of adult rat hepatocytes with another liver epithelial cell type improved the maintenance 

and reversibility of active albumin secretion.  

2.4.1.2 Micropatterning 

In a micropatterned experimental set-up (Figure 2.4 b), contact between cell 

populations is allowed but controlled by a surface pattern. Micropatterning can be done 

on glass or plastic substrates. This technique offers a great potential for generating 

different patterns shapes and sizes, and controlling the organization of co-cultures 

spatially [36]. The outcome of the culture depends on the type of micropattern as it will 

determine diffusion rates and level of separation or contact between cell populations. 

Fukuda et al. [37] applied layer-by-layer technique to create micropatterned cellular co-

cultures that included three extracellular matrix components: hyaluronic acid, fibronectin, 

and collagen. 

2.4.1.3 Temporary divider 

A temporary divider (Figure 2.4 c) is used as a physical barrier between different 

cell populations and can be removed afterwards to permit cell migration and physical 

contact. A temporary divider will help to control cell-cell contact along with spatial and 

temporal cell seeding pattern. In addition, this technique allows the manipulation of 

heterotypic and homotypic interactions of cell populations; however, it is a bit 

challenging as the individual cell compartments need to be completely sealed. 

Furthermore, the properties of the divider determine the cell response and soluble factor 

interactions. Wang et al. [38] employed a hydrogel insert as a divider for 7 days to 



14 

separate fibroblasts and osteoblasts. They demonstrated the migration of fibroblasts and 

osteoblasts into the interface region and proved that this co-culture model served as an 

excellent representation for studying the mechanism of formation of soft tissue-to-bone 

interface. 

2.4.2 Cultures without Cell-cell Contact 

2.4.2.1 Segregated co-culture 

A segregated co-culture (Figure 2.4 d) is usually employed by forming individual 

monolayers of desired cell types in their own environment on tissue culture coverslips to 

prevent cell-cell contact and putting them together in the same environment later. The 

advantage of this technique is that it is possible to analyze the response of the 

subpopulation of cells in co-culture. However, this technique might be laborious as it 

requires a multi-stage cell seeding procedure. Also, long term physical contact between 

the cell populations cannot be prevented as the cells eventually migrate, forming a 

heterogeneous culture on the coverslips [34]. D’andrea et al. [22] used this approach to 

determine the interactions between chondrocytes and synovial cells. 

2.4.2.2 Conditioned media 

In conditioned media co-culture (Figure 2.4 e), the culture media of one cell type 

is introduced into the culture of another type. Conditioned media studies help to detect 

soluble factor effects in co-culture media. A drawback of this method is deficiency of 

nutrition in one of the cell types as it obtains conditioned media instead of their own 

growth media [34]. The cells must adapt to a new environment with different growth 

supplements. This method can be advantageous for some cell types such as fibroblasts, 

osteoblasts and bone marrow stromal cells as reported by Wang et al. [39]. 
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2.4.2.3 Porous membrane 

Indirect co-cultures that use porous membranes (Figure 2.4 f) to keep the 

different cell populations physically, but not chemically apart have shown promising 

results in vitro. The membrane which acts as a physical barrier can be made of a 

transparent film and allows light to pass through so that cells at both the bottom well 

plate and insert are visible through light microscope. The porous membrane is usually 

made of polyester and the pore size and pore density can be selected according to the 

application [24]. The pore density allows for diffusion of molecules across the membrane 

and the exchange of soluble factors [40]. One of the benefits of porous membrane insert 

co-culture systems, over other methods is bi-directional signaling between the cell 

populations. In addition, cellular changes can be detected on a population-specific basis 

[41]. Snow et al. [42] investigated the paracrine signaling between ovarian cancer cells 

and fibroblasts using porous tissue culture inserts. 

2.5 Co-culture of Astrocytes and Gliomas 

A co-culture of rat brain astrocytes and gliomas represents a good experimental 

model for resembling tumor microenvironment as gliomas are a type of brain tumor 

derived from malignant transformation of astrocytes [43]. Since the growth rate of these 

two different cell types varies [44], optimization of population ratios is important so one 

cell type does not monopolize the culture [5], [45]. Astrocytes become reactive when 

they are around glioma cells, further justifying the prospect of glioma-astrocyte 

interactions [44], [46]. Gagliano et al. [43] reported that astrocytes interact with glioma 

cells via gap junctions and growth factors. Moreover, glioma cells are known to produce 

factors which in turn causes astrocytes to produce matrix metalloproteinase-2 (MMP-2), 
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an enzyme involved in the breakdown of extracellular matrix (ECM). Further, ECM 

degradation causes glioma cells to proliferate by converting pro-MMP-2 to its activated 

form [47]. Hence, in a co-culture model with rat brain astrocytes and glioma cells, the 

later abnormal cancer cells create an environment where they can thrive, ultimately 

increasing their own invasiveness [44], [47].  

Figure 2.5 is a schematic diagram of normal rat brain astrocytes alone, gliomas 

alone, and normal rat brain astrocytes and gliomas when they are put together. 

 

 

 

 

Figure 2.5: Schematic representation of a) normal rat brain astrocytes; b) glioma cells 

(CRL-2303); c) co-culture of normal rat brain astrocytes and glioma cells. 

 

 

 

According to Gullotta et al. [48], GFAP is considered as a glial-specific protein 

rather than astrocytic-specific. GFAP is visualized in all grades of gliomas. Some authors 

have indicated an inverse relationship between the degree of malignancy and the intensity 
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of GFAP expression, while others have reported that no correlation exist between 

malignancy and GFAP expression [9], [49]. β-gal has been widely used to stain only the 

glioma cells [22]. 

2.6 Neurotransmitters 

Neurotransmitters are chemical messengers that transmit signals from a neuron to 

another neuron or other target cell across a chemical synapse. Most of the 

neurotransmitters are the size of a single amino acid, but some are the size of larger 

proteins or peptides. After neurotransmitters are synthesized in the presynaptic neuron, 

they are packaged and stored in synaptic vesicles [50]. When the threshold action 

potential is reached, they are released by an active transport mechanism known as 

exocytosis into the synaptic cleft [50], [51]. After they are released into the synaptic cleft, 

they bind with neurotransmitter receptors in the postsynaptic terminal [52]. The 

interaction between a neurotransmitter and its receptor is often explained by “lock and 

key” model [53]. The receptor which acts as a “lock” can only be activated by a 

neurotransmitter which acts as a “key” if it fits perfectly into the “keyhole” 

(neurotransmitter binding site) of the lock. Most of the neurotransmitters can bind to and 

activate more than one type of receptors. However, an electrical signal (action potential) 

is necessary to release a neurotransmitter.  

Figure 2.6 is a schematic representation of a chemical synapse through which 

signals are transmitted from one neuron to another. 
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Figure 2.6: Schematic representation of a chemical synapse [54]. 

 

Neurotransmitters that excite other neurons when released and that trigger action 

potentials are known as excitatory neurotransmitters. Neurotransmitters that inhibit the 

generation of action potentials are known as inhibitory neurotransmitters. Some 

neurotransmitters can both excite and inhibit action potentials. Figure 2.7 shows the 

classification of neurotransmitters as excitatory properties, inhibitory properties, or both. 
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Figure 2.7: Classification of Neurotransmitters 

 

 

 

2.6.1 History of the Discovery of Neurotransmitters 

Acetylcholine, which acts as both excitatory and inhibitory neurotransmitter, was 

one of the first neurotransmitters discovered in 1921 [55], [56]. Otto Loewi and Henry 

Dale received the Nobel Prize in Physiology or Medicine in the year 1936 for their 

experiments with acetylcholine. Another neurotransmitter, norepinephrine, which falls 

under the same category, was discovered in 1946 [55]. In 1950, dopamine, an inhibitor 

which plays a major role in controlling brain’s reward and pleasure centers, was 

discovered [57]. In 1950, Eugene Roberts discovered GABA as an inhibitory 

neurotransmitter [58]. In 1960, serotonin was found to be present in the brain, but at the 

time, it was not considered as a neurotransmitter. In 1995, Bernard Steve Brodie used a 

special fluorometric assay to study serotonin in the brain. In 1950s, Robert Furchgott 
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demonstrated that nitric oxide can act as a “messenger molecule” in controlling the 

dilation of blood vessels [59]. The role of glycine as a neurotransmitter emerged in 1965 

when Aprison and Werman found out that the concentration of glycine is higher in the 

spinal cord tissue. The advent of glutamate as a neurotransmitter was not discerned until 

the early 1980s [60], although the role of glutamate in metabolism was well-known [61]. 

Hayashi conducted experiments with sodium glutamate and observed convulsions in 

mammals, such as dogs, monkeys, and men with excess glutamate. He later concluded 

that glutamate was a neurotransmitter in the mammalian CNS [62]. 

2.6.2 Fate of a Neurotransmitter 

Neurotransmitter released at a synapse, must be removed by one of four 

processes: 

1. Binding to its receptor on the postsynaptic neuron leading to the generation of an 

action potential. 

2. Enzymatic degradation by enzymes in the synaptic cleft on the plasma membrane of 

both the neurons. For example, acetylcholinesterase breaks down acetylcholine. 

3. Reuptake by active transport, being taken back up into the presynaptic neuron 

(recycled), which is the most common fate. 

4. Diffusion i.e. loss into the extracellular fluid (ECF). 

 Figure 2.8 shows the schematic representation of the fate of neurotransmitter 

after it is released. 



21 

 

 

Figure 2.8: [Modified] Schematic representation of the fate of neurotransmitter after it is 

released [63]. 

 

 

2.7 Glutamate 

Glutamate, an abundant amino acid [64] and a major excitatory neurotransmitter 

in the central nervous system [51], [65], [66] is crucial in learning and memory [61]. 

High concentrations of glutamate are present in the synaptic vesicles where they are 

stored as small packages in the mammalian brain [67]. However, the extracellular 

concentration of glutamate must be kept low [66], [68], [69] as excessive glutamate can 

cause a rise in Ca2+ and excitotoxicity [24], [70] wherein the neurons become too excited, 

leading to nerve damage or death [51], [66]. The intracellular glutamate concentration is 

generally three orders of magnitude higher than the extracellular concentration [27] [50], 

[71]. High levels of glutamate have been linked to neurological disorders such as 

seizures, autism, multiple sclerosis. Glutamate is cleared from the synapse by active 

transport mechanisms [70].  
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2.7.1 Chemistry of Glutamate  

The properties of glutamate are shown in Table 2.1. 

 

Table 2.1: Chemical properties of glutamate 

 

Property Value 

IUPAC Name Sodium 2-Aminopentanedioate 

Molecular Formula C5H8NO4Na 

Molar Mass 169.111 g/mol 

Appearance white crystalline powder 

Solubility in water 740 g/L 

Melting point 449.6°F 

 

The chemical structure of glutamate is shown in Figure 2.9. 

 

 

 

Figure 2.9: Chemical structure of Glutamate 
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2.7.2 Chemistry of Glutamine 

The chemical structure of glutamine is shown in Figure 2.10. 

 

 

Figure 2.10: Chemical structure of Glutamine 

 

 

 

2.7.3 Glutamate Receptors 

Because glutamate receptor proteins are present on the cell surface, they are 

capable of being active only when triggered from the outside. However, activating too 

much glutamate receptors can cause excitotoxicity of neurons. Glutamate is released from 

the presynaptic terminal into the extracellular fluid, activating glutamate receptors [51]. 

The glutamate receptors are categorized as ionotropic and metabotropic receptors. N-

methyl-D-aspartate (NMDA) receptors, AMPA (α-amino-3-hydroxy-5-methyl-4-

isoxazole propionic acid) receptors/ kainate receptors falls under ionotropic receptors. 

Metabotropic receptors belong to subfamily C of G protein-coupled receptors (GPCRs) 

and are named as mGluR#1-8 [65], [71]. Most of the cells express a minimum of one 

type of glutamate receptor. Glutamate mediates excitatory neurotransmission by binding 

to one of the three families of glutamate receptors. During seizure, there is overexcitation 

of glutamate receptors. 
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2.7.4 Glutamate Transporters 

Although there exist five subtypes of Na+ dependent glutamate transporters on 

both neurons and astrocytes [65], [66], [72], astrocytes are primarily responsible for the 

glutamate uptake in the brain [68]. Situated on the plasma membrane of neurons and glial 

cells, Na+ dependent glutamate transporters (Figure 2.11) are also known as Excitatory 

Amino Acid Transporters (EAATs) [73], [74]. EAATs are responsible for clearing 

glutamate by reuptaking from the synaptic cleft into neuronal and glial cells and 

terminating glutamatergic synaptic transmission, thus preventing glutamate spillover 

outside of the synapse [70], [72]. Glutamate neurotransmission must be terminated to 

prevent excitotoxicity by controlling the level of glutamate concentration in extracellular 

space [74], [75]. The five subtypes of Na+ dependent glutamate transporters characterized 

in humans are EAAT1-EAAT5 [73], [76]. Out of all the glutamate transporters, subtypes 

EAAT1 and EAAT2, also known as glutamate-aspartate transporter (GLAST) and 

glutamate transporter 1 (GLT-1) respectively, are primarily present in astrocytes, 

microglia, and oligodendrocytes (membranes of glial cells) [68], [77], [78]. They play a 

crucial role in maintaining low level of extracellular glutamate concentrations. The 

maximum glutamate reuptake (~90%) is achieved by EAAT2, thus preventing glutamate 

neurotoxicity [69], [79]. EAAT1 and EAAT3 (also known as excitatory amino acid 

carrier 1 (EAAC-1)) are widely present in the CNS whereas EAAT4 and EAAT5 are 

predominantly found in cerebellar Purkinje cells and retina, respectively [71], [73], [77], 

[80]. According to glutamate transport rates and anion currents, EAAT groups are 

classified into two groups: EAAT1-3 are the efficient glutamate transporters with small 

anion currents and EAAT4-5 are low capacity transporters with anion conductance [64]. 
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Mim et al. [78] demonstrated that the rate of glutamate transport varies although the 

transport mechanism is same for all the glutamate transporters. The glutamate 

transporters EAATs 1-3 are 5-10 times faster than EAAT4.     

 

 

 

Figure 2.11: Schematics demonstrating sodium-dependent glutamate transporters 

(EAAT1-EAAT4) and glutamate receptor [81]. 

 

 

 

2.7.5 Low Affinity Transporters 

Low affinity, high capacity transporter EAAT2 is the foremost glutamate 

transporters that comes into contact with presynaptically released glutamate. These low 

affinity transporters clear most of the glutamate release effectively until the glutamate 

concentrations are high and slow down when they get low. Therefore, the rate-limiting 

step is trapping of glutamate by the glutamate transporters whereas glutamate 

translocation comparatively does not take much time [78]. 
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2.7.6 High Affinity Transporters 

EAAT4 removes the glutamate molecules that were not uptaken by glial 

transporters and are capable of diffusing to a distant site (away from synaptic contacts). 

The primary purpose of EAAT4 is to inhibit the glutamate spillover to neighboring 

synapses and maintain the extracellular glutamate concentration at a submicromolar 

level. Due to its low glutamate uptake capacity, EAAT4 is not directly associated in 

terminating the synaptic transmission process. The rate of glutamate binding for EAA4 is 

one molecule in every 100 ms at 0.5 uM concentration [78]. 

2.8 Mechanism of Glutamate Removal 

High concentrations of intracellular glutamate normally do not pose a threat 

whereas high extracellular concentrations of glutamate are harmful to neurons which 

might lead to nerve damage or death [66]. As a result, glutamate should be periodically 

cleared from the extracellular space to maintain low concentrations. Since no enzymes 

present in the synapse can metabolize glutamate, cellular uptake is the only method to 

remove glutamate extracellulary. The glutamate taken up by cells in the process of 

clearing from the extracellular fluid may be recycled for protein synthesis or energy 

metabolism. In nerve terminals, the glutamate taken up is reused as transmitter via 

glutamate-glutamine shuttle [82], [83]. Failure to uptake glutamate increases the level of 

glutamate in the extracellular fluid within a short period of time. The process of 

glutamate removal is carried out due to simple diffusion from the synaptic clefts. 

However, diffusion acts fast only over very short distances (only as far as a few hundred 

nanometers). The extracellular glutamate concentration outside synapses should be low 
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for effective synaptic removal mechanism via diffusion. However, concentrations of 

extracellular glutamate might rise under disease conditions [66]. 

2.9 Glutamate-Glutamine Cycle 

The voltage gated sodium (Na+) and potassium (K+) channels generate action 

potential in the presynaptic neuron and neurotransmitters, such as glutamate, released 

from the synaptic vesicles (Figure 2.12). The uptake of glutamate by astrocytes is a 

negative feedback as it maintains the homeostasis in the brain. The glutamate is 

transported via glutamate transporters EAAT1 and EAAT2 and it is converted into 

glutamine using an enzyme glutamine synthetase. The glutamine is transported to the 

neurons where it is converted back to glutamate. This process is called the glutamate-

glutamine cycle. However, the failure of astrocytes to take up glutamate, leads to the 

activation of AMPA and NMDA receptors in the postsynaptic neuron, and in turn to the 

overexcitation of neurons in the postsynaptic terminal which might lead to epileptic 

seizures and other abnormal conditions in the brain [84]. 
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Figure 2.12: Schematic illustration of the release of neurotransmitters from the synaptic 

vesicles, glutamate-glutamine cycle, and generation of epileptic discharge [84]. 

 

 

2.10 Role of Glutamate in Epilepsy and Seizures 

Excess levels of extracellular glutamate causes excitotoxicity leading to disease 

conditions such as seizures and epilepsy [66]. Epileptogenesis is a state caused due to 

seizures persisting for a long duration causing modifications to neuronal and glial 

expression of glutamate EAATs and receptors [85]. Glutamate released from the 

synapses, which act on ionotropic and metabotropic receptors, plays a key role in the 

initiation of seizure. 

2.11 Gliomas and Excitotoxicity 

Gliomas (brain tumors) are originated due to uncontrolled proliferation of glial 

cells, primarily from astrocytes [66]. Astrocytes uptake extracellular glutamate and 

maintain homeostasis in the normal brain [16], [68]. In contrast, glioma cells are unable 
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to uptake extracellular glutamate but instead further release glutamate which might 

overwhelm and kill the neurons, thereby resulting in seizures and other abnormal 

conditions in the brain [86]. Almost 80% of individuals that suffer from brain cancer 

experience at least one seizure during their life time [87]. Glioma cells are deficient in 

GLT-1, and GLAST is underexpressed in their plasma membrane due to mislocalization 

in the nuclei [66]. As a result, 50% of the glutamate transport is achieved by Na+-

independent cystine-glutamate exchanger (system Xc
−). The increased proportion of Na+-

independent transport implies that Na+-dependent glutamate uptake is downregulated 

whereas Na+-independent system is upregulated in glioma cells [66]. This altered 

transport eventually leads to the accumulation of glutamate in the extracellular fluid and 

further causes excitotoxic neuronal death [88].     

2.11.1 The Cystine/Glutamate Antiporter System (Xc
−) 

System Xc
− is a Na+-independent cystine-glutamate exchanger found in both 

astrocytes and gliomas, however it is upregulated in glioma cells. A cystine-glutamate 

exchanger releases glutamate in exchange for cystine being imported [89]. This cystine 

acts as a precursor for the synthesis of reducing agent glutathione (GSH), which is also an 

antioxidant. The imported cystine is then reduced to cysteine within the cell and released 

into the extracellular space as shown in Figure 2.13. The cysteine further oxidizes to 

cystine and again serves as a substrate for cystine-glutamate exchange [66].  In gliomas, 

almost half of the glutamate transport relies on Na+ independent cystine-glutamate 

exchange (xc
−) [66], [90]. Recent studies have shown that glioma cells release glutamate 

and causes excitotoxic neuronal cell death, thus creating more room for tumor expansion 

[90], [91].  
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Figure 2.13: Xc- system in glioma cells [66]. 

 

2.12 Mechanism to Block Sodium-Dependent Transporters 

2.12.1 Locke’s Solution 

Locke’s solution is an aqueous solution usually comprised of sodium chloride, 

calcium chloride, potassium chloride, sodium bicarbonate, and glucose adjusted to pH 7.4 

[92]. Because Locke’s solution lacks serum and phenol red, it is suitable for most 

fluorescence experiments as it eliminates auto-fluorescence or quenching.  
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2.12.2 Chemistry of Choline Chloride 

The properties of choline chloride are shown in Table 2.2. 

 

Table 2.2: Chemical properties of choline chloride 

 

Property Value 

IUPAC Name (2-Hydroxyethyl)trimethylammonium chloride 

Molecular Formula C5H14ClNO 

Molar Mass 139.62 g/mol 

Appearance white or deliquescent crystals 

Solubility in water very soluble (>650 g/l) 

Melting point 575.6°F (302°C) 

 

 

The chemical structure of choline chloride is shown in Figure 2.14.  

 

 

 

 

Figure 2.14: Chemical structure of choline chloride 

 

 

Astrocytes uptake glutamate using sodium-dependent transporters. This sodium-

dependent glutamate uptake mechanism can be blocked by removing extracellular 

sodium and replacing it with sodium-free medium. Glutamate uptake was carried out by 
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replacing sodium chloride with choline chloride in Locke’s solution. Rosenberg et al. 

[93] found that in astrocyte-rich cultures, sodium replacement caused inactivation of 

sodium-calcium exchange, making them more sensitive to glutamate.  

2.13 MTT Assay 

The MTT assay can be used to evaluate the metabolic activity of cells. MTT [3-

(4,5-dimethylthiazol-2-yl)-2,5-diphenyltetrazolium bromide] is yellow in color, and it is 

reduced to non-water-soluble purple formazan crystals in living cells as shown in Figure 

2.15. After it is solubilized with organic solvent, the purple formazan product is dissolved 

and converted into a colored solution. The formazan product can be determined by using 

a spectrophotometry at 595 nm. MTT reduction is a measure of cellular metabolism 

which correlates to cellular toxicity. Only metabolically active cells reduce MTT to 

formazan product [94]. Ciapetti et al. [95] used the MTT assay to measure the 

compatibility of cells with different metals and polymers using MTT assay. 

 

 

 

Figure 2.15: Reaction scheme for MTT reduction [96]. 
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2.14 Apoptosis 

 Apoptosis, also known as programmed cell death, is a normal process that occurs 

in multicellular organisms for their development and continuation of life [97], [98]. 

Morphological changes during apoptosis include cell shrinkage, nuclear fragmentation, 

and chromatin condensation. Apoptosis can be initiated either through intrinsic or 

extrinsic pathway. Cell death is caused by activating caspases or enzymes that cause 

degradation of proteins. Morphological changes in cell culture caused by apoptosis can 

be visualized under microscope within few hr. Cell and nuclei shrinkage can be used as a 

measure to quantify the extent of apoptosis in culture using image analysis. Nuclear Area 

Factor (NAF) [99] can be a beneficial tool to quantify apoptotic cells and it is given by 

the product of area and roundness of the nuclei. NAF will be calculated in this project to 

evaluate apoptosis induced by staurosporine, an apoptotic agent.  

2.15 Necrosis 

Necrosis is a form of cell death caused by injury or other factors such as infection, 

toxins, or trauma [100]. Morphological changes during necrosis include cell swelling, 

plasma membrane rupture and loss of intracellular contents. Cellular leakage may cause 

an inflammatory response. In contrast to apoptosis, necrosis is uncontrolled cell death. 
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CHAPTER 3 

 

USE OF A TWO-DIMENSIONAL IN VITRO CO-CULTURE MODEL 

WITH NORMAL BRAIN ASTROCYTES AND GLIOMA CELLS 

FOR ENGINEERING THE TUMOR MICROENVIRONMENT 
 

3.1 Introduction 

Gliomas are primary malignant brain tumors and they originate from neoplastic 

transformation of astrocytes [43], [66]. However, the mechanisms by which glioma cells 

migrate and invade healthy cells is yet to be understood [101]. The reactive astrocytes 

around the glioma cells suggests that these two cell types could be interacting [47], [102]. 

The mode of communication between the gliomas and normal brain astrocytes are 

thought to be via gap junctions and growth factors. Moreover, the mechanism underlying 

the role of gap junctions in the interaction of astrocytes with glioma cells and tumor 

invasiveness is yet to be explored [103].  

The microenvironment for cancer, includes both tumor cells and healthy cells. A 

co-culture model is a useful system to study cell-cell interactions between different cell 

populations in vitro. Some cell types exhibit different behavior than their desired 

physiological behavior in the presence of another cell population. In some instances, the 

cell populations vary in their growth rates making one of the cell type dominant over the 

other [5]. Engineering a co-culture environment, where both tumor and normal cells grow 

together, will help understand the mechanisms of cancer.   
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Herein, a mixed co-culture model of normal brain cells and tumor cells was 

created to engineer the tumor microenvironment and to study whether glioma cells 

become more invasive by manipulating astrocytes. This co-culture system may serve as a 

useful tool in studying the interactions of glioma cells with normal brain cells. 

3.2 Materials and Methods 

3.2.1 Cell Culture 

CRL-2303 (C6/lacZ7) rat glioma cells were obtained from American Type 

Culture Collection (ATCC) and seeded at densities 4,000 and 8,000 cells per mL in a 48-

well plate and grown in CRL-2303 culture media (Appendix A, Section A.1). 

Primary astrocytes from newborn rat tissues were seeded at densities 12,000 and 

24,000 cells per mL in a 48-well plate, and grown in astrocyte growth media (Appendix 

A, Section A.2). 

For a co-culture experimental model, a mixed co-culture method was employed. 

Glioma cells (CRL-2303) and normal brain astrocytes were seeded in the ratio 1:3 in their 

respective growth media into the same well with direct cell-cell contact in a 48-well cell 

culture plate (Griener) and allowed to grow in an incubator with 5% CO2 at 37 °C for 3 

days. The ratio of 1:3 was determined experimentally due to the fast growth rate of 

glioma vs. astrocytes. 

To demonstrate tumor invasiveness over time, glioma cells (CRL-2303) and 

normal brain astrocytes were seeded in the ratio 1:4 in a 24-well cell culture plate in the 

same conditions as mentioned above. Further, the ability of reduced fetal bovine serum 

(FBS) to induce senescence [104] in glioma cells was tested. 
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3.2.2 Cell Fixation 

After 3 days in vitro, the growth medium from the cells was aspirated and washed 

twice with 500 uL 1X PBS. Cells were fixed (Appendix B) using the fixation solution 

from β-gal kit such that it covers the entire well and the plate was kept at room 

temperature for 10 minutes. The cells were rinsed twice with 500 uL 1X PBS again. 

3.2.3 GFAP Staining  

To confirm normal in vitro characteristics, cells were stained using indirect 

immunofluorescence for glial fibrillary acidic protein (GFAP), a cytoskeletal protein 

found specifically in glial cells. Cells were stained using Anti-GFAP, antibody produced 

in rabbit as 1° Ab from Sigma-Aldrich (Sigma Product #G9269), and Alexa Fluo® 488 

goat anti-rabbit IgG (H+L) as 2° Ab from Invitrogen Molecular Probes (Invitrogen 

Product #A-11035) (Appendix C). 

3.2.4 β-gal Staining 

As the GFAP stained both astrocytes and glioma cells, CRL-2303 cells were 

counterstained with β-gal staining to distinguish between the cell types in a co-culture 

experimental model (Appendix D). The β-galactosidase Reporter Gene Staining Kit was 

obtained from Sigma-Aldrich (Sigma Product #GALS). 

3.2.5 DAPI Staining 

Nuclei were stained with 4,6-diamidino-2-phenylindole (DAPI) to confirm cell 

viability and to compare the nuclei of glioma cells and astrocytes in a co-culture 

experimental model (Appendix E). 
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3.2.6 Microscopy 

Microscopic images of the cells were recorded using a Leica DMI 6000B inverted 

microscope. β-gal staining was viewed using phase-contrast microscopy whereas GFAP 

staining was viewed using fluorescence settings. For fluorescent imaging, a Leica 

EL6000 light source was used. For GFAP imaging, excitation in the blue portion of the 

light spectrum (~475 nm) was required. To view DAPI-stained nuclei, excitation light in 

the ultraviolet range (~400 nm) was required. GFAP emits green light and DAPI emits 

blue light. 

3.2.7 Image Analysis 

All image analysis was done with Image-Pro Plus version 7.0 developed by 

Media Cybernetics. The total area covered by glioma cells and normal brain astrocytes 

was determined by analyzing the GFAP and β-gal staining for each image (Appendix F). 

The ratio was then calculated to give the percentage of glioma cells and normal brain 

astrocytes that cover the total area. For images stained with DAPI, the total number of 

nuclei (objects) and the total area covered by nuclei were calculated. To verify if the ratio 

for the co-culture changes over time as the glioma cells grow fast, the percentage of area 

covered by glioma cells is calculated from the β-gal stained images. 

3.3 Results 

3.3.1 GFAP Staining 

 Figures 3.1 and 3.2 show images of different densities of normal brain astrocytes 

before and after GFAP staining. Figures 3.3 and 3.4 show images of different densities 

of glioma cells before and after GFAP staining. In all figures, the left panel shows phase 

contrast images before GFAP staining and the right panel shows fluorescence images of 
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the same fields after GFAP staining. The images in the top row are positive control with 

both primary and secondary antibodies (1° Ab + 2° Ab) and they stained positive for 

GFAP staining. The images in the bottom rows are negative control with no primary 

antibody (1° Ab) and they did not show any staining.  

 

 

Figure 3.1: GFAP staining for 12,000 normal brain astrocytes cells per mL. The left 

panel shows phase contrast images before GFAP staining and the right panel shows 

fluorescence images after GFAP staining. The images in the top row are positive control 

with both primary and secondary antibodies (1° Ab + 2° Ab) and the images in the 

bottom row are negative control with no primary antibody (1° Ab). Scale bar = 100 um. 

 

 

 

Fine astrocyte processes stained with GFAP were observed under fluorescence 

microscopy as shown in top rows (Figures 3.1 and 3.2). 
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Figure 3.2: GFAP staining for 24,000 normal brain astrocytes cells per mL. The left 

panel shows phase contrast images before GFAP staining and the right panel shows 

fluorescence images after GFAP staining. The images in the top row are positive control 

with both primary and secondary antibodies (1° Ab + 2° Ab) and the images in the 

bottom row are negative control with no primary antibody (1° Ab). Scale bar = 100 um. 

 

 

 

Different densities of glioma cells (CRL-2303) were stained with GFAP. Figure 

3.3 shows phase contrast images and fluorescence images of 4,000 glioma cells per mL 

before and after GFAP staining. 
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Figure 3.3: GFAP staining for 4,000 glioma cells (CRL-2303) per mL. The left panel 

shows phase contrast images before GFAP staining and the right panel shows 

fluorescence images after GFAP staining. The images in the top row are positive control 

with both primary and secondary antibodies (1° Ab + 2° Ab) and the images in the 

bottom row are negative control with no primary antibody (1° Ab). Scale bar = 100 um. 

 

 

 

Next, the density of glioma cells (CRL-2303) was doubled and stained with 

GFAP. Figure 3.4 shows phase contrast and fluorescence images of 8,000 glioma cells 

per mL before and after GFAP staining. 
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Figure 3.4: GFAP staining for 8,000 glioma cells (CRL-2303) per mL. The left panel 

shows phase contrast images before GFAP staining and the right panel shows 

fluorescence images after GFAP staining. The images in the top row are positive control 

with both primary and secondary antibodies (1° Ab + 2° Ab) and the images in the 

bottom row are negative control with no primary antibody (1° Ab). Scale bar = 100 um. 

 

 

 

Although GFAP is a specific marker for astrocytes, gliomas stained positive for 

GFAP staining as well because the gliomas are derived from astrocytes. Thereafter, 

different densities of gliomas were stained with β-gal. 

3.3.2 β-gal Staining 

Glioma cells (CRL-2303) were stained with a β-gal staining kit and the cells were 

visualized under the microscope. Figure 3.5 shows phase contrast microscopy images for 
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4,000 cells per mL glioma cells before and after β-gal staining. The β-gal stained the 

glioma cells with an indigo blue color under phase contrast microscopy. 

 

  

 

Figure 3.5: β-gal staining for 4,000 glioma cells (CRL-2303) per mL. The left panel 

shows the image before β-gal staining and right panel shows the same image after β-gal 

staining. All the images are obtained using phase contrast microscopy. Scale bar = 100 

um. 

 

 

 

Next, the density for glioma cells was doubled and stained with β-gal. Figure 3.6 

shows phase contrast microscopy images for 8,000 cells per mL glioma cells before and 

after β-gal staining.   
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Figure 3.6: β-gal staining for 8,000 glioma cells (CRL-2303) per mL. The left panel 

shows the image before β-gal staining and the right panel shows the same image after β-

gal staining. All the images are obtained using phase contrast microscopy. Scale bar = 

100 um. 

 

 

 

3.3.3 Staining Co-culture with GFAP and β-gal 

Figure 3.7 shows co-culture of 4,000 glioma cells (CRL-2303) per mL and 

12,000 normal brain astrocytes per mL. The left panels show phase contrast microscopy 

images before they were stained with GFAP and β-gal. In the co-culture experimental 

model, both normal brain astrocytes and glioma cells (CRL-2303) stained positive for 

GFAP staining as shown from the middle panel (top row), the top row is positive control 

with both primary and secondary antibodies (1° Ab + 2° Ab) and the bottom row is 

negative control with no primary antibody (1° Ab). The images in the right panel are the 

same fields after the cells were stained with β-gal. Gliomas stained positive where as 

normal brain astrocytes stained negative for β-gal staining as shown in right panels.  
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Figure 3.7: Control (no staining), GFAP and β-gal staining for co-culture of 4,000 

glioma cells (CRL-2303) per mL and 12,000 normal brain astrocytes per mL. The left 

panel (Control) and the right panel (after β-gal staining) are the images obtained with 

phase contrast microscopy. The middle panel (after GFAP staining) are the images 

obtained with fluorescence microscopy, the top row is positive control with both primary 

and secondary antibodies (1° Ab + 2° Ab) and the bottom row is negative control with no 

primary antibody (1° Ab). Scale bar = 100 um. 

 

 

 

Figure 3.8 shows co-culture of 8,000 glioma cells (CRL-2303) per mL and 

24,000 normal brain astrocytes per mL. 
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Figure 3.8: Control (no staining), GFAP and β-gal staining for co-culture of 8,000 

glioma cells (CRL-2303) per mL and 24,000 normal brain astrocytes per mL. The left 

panel (Control) and the right panel (after β-gal staining) are the images obtained with 

phase contrast microscopy. The middle panel (after GFAP staining) are the images 

obtained with fluorescence microscopy, the top row is positive control with both primary 

and secondary antibodies (1° Ab + 2° Ab) and the bottom row is negative control with no 

primary antibody (1° Ab). Scale bar = 100 um. 

 

 

 

There were no notable changes in morphology in the co-culture of glioma cells 

with astrocytes as compared to glioma cells alone and astrocytes alone (Figures 3.7 and 

3.8). 

After staining with GFAP and β-gal, the percentage of total area of the image 

covered by different densities of CRL-2303 and astrocytes at 3 days in vitro (div) were 

calculated using Image-Pro Plus version 7.0 and the results are as shown in Table 3.1.  
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Table 3.1: Total area of the image covered by different densities of gliomas (CRL-2303) 

and astrocytes at 3 days in vitro (div) (in %) 

 

 

 

4k CRL-

2303 

 

8k CRL-

2303 

 

12k 

Astros 

 

24k 

Astros 

4k CRL-2303 + 

12k Astros 

8k CRL-2303 + 

24k Astros 

CRL-

2303 

Astros CRL-

2303 

Astros 

12.2 34.4 21.0 45.7 7.01 40.7 14.8 37.5 

10.2 34.1 25.5 41.1 9.03 21.4 28.1 15.9 

13.9 32.0 25.4 47.4 10.0 40.3 11.7 39.3 

 

 

 

As shown in Table 3.1, after 3 div, the total area of the image covered by gliomas 

(CRL-2303) increased by almost three-fold whereas the total image area covered by 

astrocytes increased by almost two-fold as the density of the cells was increased two 

times when they were cultured alone. This is due to the fast growth of gliomas than 

astrocytes. Also, the cell bodies of astrocytes are bigger than gliomas, hence they occupy 

more area than gliomas. However, when the densities of both cell populations were 

doubled, the culture become crowded and much more variation was observed. Thus, the 

cells behave differently in a co-culture setup. The total area of the image covered by 

gliomas decreased when the cells were in co-culture with astrocytes as compared to when 

they were cultured alone. Hence, we concluded that the presence of astrocytes creates 

less room for gliomas to grow at 3 days in vitro, but gliomas take over the astrocytes over 

time as shown later in this chapter.  

3.3.4 Identifying Cell Types Using Size and Shape of Nuclei 

Cells were stained with DAPI after 3 div to compare the nuclei of glioma cells 

and astrocytes in a co-culture experimental model. Figure 3.9 shows the images for 

qualitative morphological analysis of DAPI-stained nuclei for different densities of 
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glioma cells alone, normal brain astrocytes alone, and co-cultured glioma cells with 

astrocytes.  
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Figure 3.9: Fluorescence images of DAPI-stained nuclei for different densities (per mL) 

of glioma cells alone (CRL-2303), normal brain astrocytes alone, and co-cultured glioma 

cells and astrocytes. Scale bar = 100 um. 
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Figure 3.9 shows the nuclei of astrocytes are larger than those of glioma cells 

(CRL-2303) and that they are elongated in shape irrespective of the different densities of 

cells. There were no differences in the nuclei of cells in co-culture as compared to when 

they were cultured alone. Hence, the shape and size of the DAPI-stained nuclei are useful 

factors to distinguish the glioma cells and the astrocytes in a co-culture model. However, 

a brighter nuclear staining was observed for astrocytes than glioma cells in a mixed 

culture because β-gal, which was used to stain glioma cells, quenches the DAPI staining. 

Figure 3.10 are the images for distinguishing normal brain astrocytes from 

glioma cells based on the size and shape of nuclei in a co-culture model. These results are 

further supported with the same images from β-gal staining.  

 

 
 

 

Figure 3.10: Control, DAPI-stained nuclei, and β-gal staining for co-culture of 4,000 

cells per mL gliomas (CRL-2303) and 12,000 cells per mL normal brain astrocytes. Left 

panel represents phase contrast images (Control), middle panel shows fluorescent images 

of DAPI-stained nuclei, and right panel shows the same phase contrast images after 

staining with β-gal. Yellow arrows show glioma cells and white arrows show normal 

brain astrocytes. Scale bar = 100 um. 

 

 

 

Next, the densities of cells in co-culture were increased and the microscopic 

images were obtained as shown in Figure 3.11. 
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Figure 3.11: Control, DAPI-stained nuclei, and β-gal staining for co-culture of 8,000 

cells per mL gliomas (CRL-2303) and 24,000 cells per mL normal brain astrocytes. Left 

panel shows phase contrast images (Control), middle panel shows fluorescent images of 

DAPI-stained nuclei, and right panel shows the same phase contrast images after staining 

with β-gal. Yellow arrows show glioma cells and white arrows show normal brain 

astrocytes. Scale bar = 100 um. 

 

 

 

Yellow arrows point to glioma cells, where the nuclei are characterized by their 

smaller size, fainter appearance, and the take up of β-gal stain. White arrows point to 

normal brain astrocytes with elongated bright nuclei and lack of β-gal stain.  

 The average number of nuclei (objects) and average area covered by cells were 

studied for two different densities of glioma cells alone, normal brain astrocytes alone, 

and co-culture of both cells. Figure 3.12 shows the average number of nuclei after three 

days for various seeding densities of glioma cells alone, normal brain astrocytes alone, 

and co-culture of both cells. When the seeding densities of cells were doubled, the 

number of nuclei in glioma cells after three days increased by more than two-fold, 

whereas the number of nuclei in astrocytes did not change significantly. This result 

indicates that glioma cells grow faster than astrocytes. However, the number of nuclei 

remained constant with the increasing densities of cells in co-culture. It was observed that 

with the increasing number of both gliomas and astrocytes in a co-culture setup, the cells 

eventually reach confluence and cease to grow.  
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Figure 3.12: Average nuclei number covered by gliomas alone, normal brain astrocytes 

alone, and co-culture of gliomas with astrocytes after 3 days in vitro (div). Error bars 

indicate standard deviation (SD); * P < 0.05, n = 9. 

 

 

 

Figure 3.13 shows the average nuclei area after three days covered by various 

seeding densities of glioma cells alone, normal brain astrocytes alone, and co-cultures of 

glioma cells and astrocytes. The average nuclei area covered by glioma cells cultured 

alone was approximately 1,600 square pixels, whereas the average nuclei area covered by 

normal brain astrocytes cultured alone was approximately 4,000 square pixels. Results 

showed that the average area covered by nuclei of normal brain astrocytes was almost 

60% more than glioma cells. For co-culture of both glioma cells and astrocytes, the 

average area covered by nuclei was 2,500 square pixels, which was 56% larger than the 

area covered by glioma cells alone. As expected, the varying seeding densities of cells 

did not affect the average nuclei area for each cell type. The average nuclei area covered 

by cells was not significant within the same cell type but significant with different cell 

populations.  
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Figure 3.13: Average nuclei area covered by gliomas alone, normal brain astrocytes 

alone, and co-culture of gliomas with astrocytes after 3 days in vitro (div). Error bars 

indicate standard deviation (SD); * P < 0.05, n = 9. 

 

 

 

From Figures 3.12 and 3.13, the cell nuclei of astrocytes in monocultures occupy 

more cell area than the cell nuclei of glioma cells in monoculture because the average 

area of nuclei for astrocytes is larger than that of glioma cells even though astrocyte 

culture has fewer nuclei than the glioma cell culture. The gliomas have much smaller 

nuclei than astrocytes.  

3.3.5 Tumor Invasion in Co-culture 

Next, it was hypothesized that the tumor invasiveness increases over time in a co-

culture model. To demonstrate this, β-gal staining was used as shown in Figure 3.14 and 

the percentage area of the image covered by glioma cells was calculated over 8-day 

period as demonstrated in Figure 3.15.  

0

1000

2000

3000

4000

5000

4k CRL-

2303

8k CRL-

2303

12k Astros 24k Astros 4k CRL-

2303 + 12k

Astros

8k CRL-

2303 + 24k

Astros

P
ix

el
 A

re
a

Density of cells (per mL)

*



53 

 

 

Figure 3.14: β-gal staining on co-culture of 3,000 glioma cells (CRL-2303) per mL and 

12,000 normal brain astrocytes per mL at a) Day 2, b) Day 4, c) Day 6, and, d) Day 8. 

Scale bar = 100 um. 

 

 

 

Glioma cells are stained indigo blue by the β-gal staining. The images show that 

glioma cells dominate the co-cultures. Whereas the astrocytes outnumber glioma cells at 

Day 2, by Day 8 the tumor cells are so numerous that they may be inhibiting the growth 

of normal brain astrocytes. 

These results are shown quantitatively in Figures 3.15 and 3.16. Figure 3.15 

shows the graph for total area coverage by β-gal staining in a co-culture model over 8-
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day period, demonstrating an increase from 1.8% to 90.7%. In contrast, the total area 

without staining decreased by an order of magnitude, as shown in Figure 3.16. 

 

 
 

Figure 3.15: Total area coverage (%) by β-gal staining on co-culture of 3,000 glioma 

(CRL-2303) cells per mL and 12,000 normal brain astrocytes per mL over time. 

 

 
 
 

Figure 3.16: Total unstained area (%) on co-culture of 3,000 glioma cells (CRL-2303) 

per mL and 12,000 normal brain astrocytes per mL over time. 
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Part of the non-stained area is astrocytes, while the rest is surface area that is not 

covered by cells at all. As the cells become more confluent, this open area decreases. The 

chart shows, however, that the ratio of the area covered by glioma cells to area covered 

by astrocytes is increasing, given that the ratio of cells at seeding is 1 to 4, whereas the 

area coverage at Day 8 is at least 10 to 1. 

Changes in shape and size of cells were observed over time, so DAPI staining was 

used to compare the nuclei over time and the results are shown in Figure 3.17. 

 

 

Figure 3.17: DAPI staining on co-culture of 3,000 glioma cells per mL (CRL-2303) and 

12,000 normal brain astrocytes per mL at a) Day 2, b) Day 4, c) Day 6, and, d) Day 8. 

Scale bar = 100 um. 
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 Figures 3.14 and 3.17 show that the cell bodies and nuclei get smaller over time. 

The number of nuclei were comparatively less on Day 2 than on Days 4, 6 and 8. By Day 

8, the nuclei of the cells were packed, and the shape of the nuclei were rounder.  

3.4 Conclusion and Discussion 

Due to the different growth characteristics of the cell lines, a co-culture 

experimental model can be complex. Here, a co-culture model of normal brain astrocytes 

and brain tumor cells was developed. In this co-culture model, the brain tumor cells grow 

rapidly due to autocrine and paracrine signaling between cells [2], whereas the normal 

brain astrocytes proliferated more slowly. Here, GFAP and β-gal staining were used to 

distinguish between the two populations of cells in a co-culture model. 

GFAP, a marker for glial cells stained positive for both normal brain astrocytes 

and brain tumor cells. One of the reasons behind positive staining of glioma cells for 

GFAP is that glioma cells are derived from glial cells [43], [90], [91]. In this study, β-gal 

was used to stain only the glioma cells but not normal brain astrocytes. Normal brain 

astrocytes stained negative to β-gal whereas brain tumor cells turned indigo blue color. 

The β-gal kit is extremely sensitive to fixatives. Ma et al. tested the effect of different 

fixatives and reported that Carnoy’s solution hampered the β-gal activity [105]. Our data 

suggest that GFAP should be done prior to β-gal staining as quenching and 

downregulation of GFAP were observed in glioma cells after β-gal staining. Nuclear 

shape and size are distinct properties of any cell type [106] and may be useful in 

distinguishing between the different cell populations.  

Initially, the astrocytes thrive in the presence of glioma cells creating less room 

for the gliomas to grow, but later the gliomas take over the astrocytes. Astrocytes secrete 
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matrix metalloproteinase (MMP-2) precursor and it is thought that glioma cells use 

MMP-2 dependent pathway to exploit astrocytes for tumor invasiveness [107]. Results 

showed that the presence of glioma cells suppress the growth of healthy brain cells over 

time, thus facilitating tumor invasiveness. These findings are consistent with the reports 

from Gagliano et al. [44], [45]. Since astrocytes have the ability to proliferate, they might 

be transformed into glioma overtime as the cellular origins of gliomas are astrocyte 

precursor cells. The interaction of astrocytes with tumor cells via gap junctions causes an 

increase in intracellular calcium causing difficulties in chemotherapeutic treatments. 

Recent studies have shown that glioma cells release glutamate at sufficiently large 

concentrations to cause neuronal cell death [108]. Glioma invasion might also be linked 

to astrocytes going through phenotype modification/ transformation and the tumor cells 

losing their expression over time. Moreover, studies have shown that sulfasalazine can 

cause inhibition of glioma invasion [108], [109].  

Fetal bovine serum (FBS) did not induce senescence in glioma cells [104]. It was 

noted that the glioma cells might lose expression over time and might not stain all the 

cells with indigo blue color. Thus, a mixed co-culture experimental model of normal 

brain cells and tumor cells is suitable to study cell-cell interactions in tumor 

microenvironment. Further, the model serves as a useful tool in understanding the growth 

of tumor in the brain. 

 



58 

 

CHAPTER 4 

 

STUDYING GLUTAMATE UPTAKE IN A CO-CULTURE 

EXPERIMENTAL MODEL OF NORMAL BRAIN ASTROCYTES 

AND GLIOMA CELLS 
 

4.1 Introduction 

Glutamate is the major excitatory neurotransmitter in the brain. Glutamate 

transporters EAAT1 and EAAT2, primarily found in astrocytes, clear glutamate from the 

extracellular space by a glutamate uptake mechanism [74], [110]. Under normal 

physiological conditions, the concentration of glutamate in the brain is tightly regulated 

[7]. However, gliomas release glutamate through system xc
- cystine-glutamate transporter 

[111].  

Brown et al. [112] showed enhanced uptake of glutamate by astrocytes when 

astrocytes were co-cultured with cerebellar neurons. Failure to uptake glutamate from the 

extracellular space causes excitotoxicity to the neurons which might lead to disease 

conditions such as seizure and epilepsy [85]. In a diseased state such as cancer, both 

glioma cells, and normal brain astrocytes are present. However, glutamate uptake in 

systems containing both astrocytes and glioma cells has not been studied. A clear 

understanding of the glutamate uptake in the presence of both cell types is essential to 

controlling glutamate toxicity. 

Here, glutamate uptake was measured in normal brain astrocytes and glioma cells 

(CRL-2303) individually as well as in the co-culture model developed as discussed in 
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Chapter 3. The aim of this study was to investigate glutamate uptake in the presence of 

both astrocytes and glioma cells. Further, we observed the morphological changes in 

astrocytes in sodium-free medium by blocking sodium-dependent transporters.  

4.2 Materials and Methods 

4.2.1 Cell Culture 

CRL-2303 (C6/lacZ7) rat glioma cells were obtained from American Type 

Culture Collection (ATCC) and seeded in a 24-well plate at densities 50,000, 100,000, 

and 200,000 cells per mL in growth media containing DMEM-high glucose, including 

4500 mg/L glucose, L-glutamine, and sodium bicarbonate, without sodium pyruvate 

(Sigma-Aldrich) with fetal bovine serum (10% v/v), MEM non-essential amino acid 

solution 100x (1% v/v), and penicillin/streptomycin (0.5% v/v) added (Appendix A, 

Section A.1).  

Astrocytes from primary newborn rat tissues were seeded at densities 50,000, 

100,000, and 200,000 cells per mL in a 24-well plate, grown in Nutrient Mixture F-12 

Ham plus L-glutamine and sodium bicarbonate (Sigma-Aldrich) with horse serum (5% 

v/v), fetal bovine serum (5% v/v), and penicillin/streptomycin (0.5% v/v) (Appendix A, 

Section A.2), and placed in an incubator with 5% CO2 and 37 °C until they reached 

~80% confluency.  

For a co-culture experimental model, normal brain astrocytes and glioma cells 

(CRL-2303) were seeded in the ratio 3:1 into the same well in their respective growth 

media with direct cell-cell contact in a 48-well cell culture plate (Griener) and allowed to 

grow in an incubator for 3 days. After that, glutamate assay was performed to measure 

the glutamate uptake in co-culture.  
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4.2.2 Glutamate Assay  

For quantitative colorimetric determination of glutamate, an Enzychrom™ 

Glutamate Assay Kit (#EGLT-100) was obtained from BioAssay Systems and used 

according to standard protocols. Cells were preincubated with 100 uM glutamate for 5 hr 

in an incubator maintained at 5% CO2 and 37 °C. Then, 20 uL sample was transferred to 

a 96-well plate and 80 uL working reagent was added on top of it. Standard curves (100-

400 uM) were prepared as well. The plate was slightly tapped to mix the sample and 

reagent briefly and thoroughly. Spectrophotometric measurements were carried out using 

Thermoscientific Multiskan Spectrum. Optical densities for time “zero” (OD0) and after a 

30-min incubation (OD30) were measured at 565 nm. For the standard and sample wells, 

OD0 was subtracted from OD30. Glutamate levels in the media were determined. 

4.2.3 Sodium (Na+) Transport Test 

Choline Chloride (MW=139.62 g/mol) was obtained from Sigma-Aldrich (St. 

Louis, MO). The exposure medium was Locke’s solution (Appendix A, Section A.4) 

whereas sodium chloride was replaced with choline chloride for sodium-transport 

experiments. 

4.2.4 MTT Assay 

MTT [3-(4,5-dimethylthiazol-2-yl)-2,5-diphenyltetrazolium bromide] was 

obtained from Thermo Fisher Scientific (Waltham, MA). MTT assay is a biochemical 

assay used to determine the metabolic rate of cells. To determine if the presence of 

glutamate had any effect on cells, MTT assay was carried out in the presence and absence 

of 100 uM glutamate. The stock concentration (5 mg/mL) of MTT, a yellow tetrazole, 

was diluted in DMEM without phenol red to obtain a final concentration of 1.25 mg/mL. 
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After that, media was aspirated from each well and 400 uL of MTT was added. The well 

plate was wrapped with aluminum foil and placed in the incubator for 60 minutes. After 

the incubation period, purple colored formazan crystals were observed, and they were 

dissolved with 300 uL of 91% isopropyl alcohol and mixed to lyse the cells. The samples 

were measured at 570 nm using a 96-well microplate plate reader (Thermoscientific 

Multiskan Spectrum). The absorbance values were assumed to be directly proportional to 

the number of viable cells. 

4.2.5 Statistics 

Data analysis was performed in Microsoft Excel and the significance of the test 

results was analyzed using Students t-test. A p-value less than 0.05 was considered 

statistically significant.   

4.3 Results 

4.3.1 Glutamate Uptake 

After 3 days in vitro, 100 uM glutamate was added to different densities of 

normal brain astrocytes and glioma cells and incubated at 37 °C and 5% CO2 for 5 hr. 

Microscopic images were recorded to observe the changes in morphology of cells before 

and after addition of glutamate. Figure 4.1 shows the morphological changes in normal 

brain astrocytes before and after preincubation with 100 uM glutamate.  
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Figure 4.1: Microscopic images of 100k, 50k and 25k cells per mL normal brain astrocytes 

after 5 days in vitro (div) before and after preincubation with 100 uM glutamate for 5 hr at 

37 °C. Scale bar = 200 um. Dotted square lines mark the same area between the left and 

right image and show that the morphology of the cells remained the same before and after 

addition of 100 uM glutamate. 

 

 

 

Next, different densities of glioma cells were preincubated with 100 uM 

glutamate for 5 hr at 37 °C and 5% CO2. Microscopic images of the same area of the 

wells were recorded before and after addition of 100 uM glutamate. The microscope’s 

internal coordinate system was used to take images at specific locations at several time 

points. Figure 4.2 shows the morphological changes in glioma cells before and after 
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preincubation with 100 uM glutamate. The addition of 100 uM glutamate did not cause 

any visible signs of cellular stress over 5 hr. 

 

 

 

Figure 4.2: Microscopic images of 50k, 25k and 10k cells per mL glioma cells (CRL-

2303) after 3 days in vitro (div) before and after preincubation with 100 uM glutamate for 

5 hr at 37 °C. Scale bar = 100 um. Dotted square lines mark the same area between the left 

and right image and show that the morphology of the cells remained the same before and 

after addition of 100 uM glutamate. 
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Next, an Enzychrom™ Glutamate Assay Kit was used to measure the amount of 

extracellular glutamate. Figure 4.3 shows the glutamate uptake by different densities of 

normal brain astrocytes and glioma cells grown in monoculture.  

 

 

 

Figure 4.3: Percentage of glutamate uptake by different densities of normal brain 

astrocytes and glioma cells (CRL-2303) at 3 days in vitro (div) after preincubation with 

100 uM Glu for 5 hr at 37 °C. Error bars indicate standard deviation (SD); * P < 0.05, n = 

3. 

 

 

 

Glutamate uptake by normal brain astrocytes and glioma cells increased in a 

density-dependent manner. For 200k, 100k, and 50k cells per mL, normal brain astrocytes 

showed glutamate uptake of 67.7%, 41.7%, and 15.9% respectively. In contrast, under the 

same conditions, glioma cells showed 10.1%, 8.2% and 2.5% respectively. The ratio of 

uptake for glutamate between normal brain astrocytes and glioma cells was about 6:1 for a 

seeding of 200k cells per mL, about 5:1 for a seeding of 100k cells per mL and then 6:1 

again when the seeding density was 50k cells per mL. Therefore, glutamate uptake by 
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normal brain astrocytes exhibited approximately a six-fold increase compared to glioma 

cells for all three densities of cells used. These data show that the uptake of glutamate is 

greatly lower in glioma cells compared with normal brain astrocytes. An increased number 

of astrocytes leads to more glutamate uptake from the extracellular fluid. This increase may 

be caused by the increase in sodium-dependent transporters EAAT1 and EAAT2 as the 

density of astrocytes is increased. 

Figure 4.4 shows the morphological changes in co-culture consisting of various 

densities of glioma cells and normal brain astrocytes before and after preincubation with 

100 uM glutamate. 
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Figure 4.4: Microscopic images of co-culture of 4,000 glioma cells per mL and 12,000 

normal brain astrocytes per mL, and 8,000 gliomas per mL and 24,000 normal brain 

astrocytes per mL at 3 days in vitro (div) before and after preincubation with 100 uM 

glutamate for 5 hr at 37 °C. Scale bar = 100 um. Dotted square lines mark the same area 

between the left and right image and show that the morphology of the cells remained the 

same before and after addition of 100 uM glutamate. 

 

 

 

The addition of 100 uM glutamate did not lead to visible signs of cellular stress in 

co-culture after 5 hr. The slight change in cell morphology was attributed to the normal 

continued growth of the cells. 

The glutamate uptake was repeated, as explained earlier, in a co-culture of normal 

brain astrocytes and glioma cells.  

Figure 4.5 shows the glutamate uptake by different densities of normal brain 

astrocytes and co-culture of normal brain astrocytes and glioma cells. 
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Figure 4.5: Percentage of glutamate uptake by different densities of normal brain 

astrocytes and glioma cells, 3 days in vitro (div) after preincubation with 100 uM Glu for 

5 hr at 37 °C. Error bars indicate standard deviation (SD); * P < 0.05, n = 3. 

 

 

 

 The uptake of glutamate by astrocytes after 3 div was 2.77% for cells seeded at 

12,000 cells per mL and 13.85% for cells seeded at 24,000 cells per mL. The co-culture of 

4,000 cells per mL CRL-2303 and 12,000 cells per mL astrocytes saw an increase in uptake 

of glutamate by seven-fold and reached 19.4% as compared to 12,000 cells per mL 

astrocytes alone. The co-culture of 8,000 cells per mL CRL-2303 and 24,000 cells per mL 

astrocytes had a glutamate uptake of 32.5% as compared to 12,000 cells per mL astrocytes 

alone. Surprisingly, the co-culture of astrocytes with brain tumor cells enhanced the uptake 

of glutamate. This enhancement indicates the complex interplay between upregulation of 

glutamate uptake and the composition of different cell types in co-cultures. In case of co-

cultures, as the brain tumors progress, there might be more mass of cells and that might 

have affected the astrocytes. These data also suggest that the impaired uptake by gliomas 

might have caused the astrocytes to work harder in uptaking more glutamate. 
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4.3.2 Cell Metabolism 

To study possible effects of glutamate on the cells, MTT assay was used to further 

examine the metabolism of cells. Figure 4.6 shows the metabolism of cells with and 

without 100 uM glutamate. The data show no significant difference in the metabolism of 

cells with and without 100 uM glutamate. 

 

  

Figure 4.6: MTT assay as a measure of cell metabolism with and without 100 uM 

glutamate. Error bars indicate standard deviation (SD); n.s.= not significant at P < 0.05, n 

= 4. 

 

 

 

 In all cases, the metabolism increased with seeding density. While the mean 

values of metabolism increased with the addition of glutamate, the effect was not 

statistically significant. This study indicates that the glutamate did not cause cell injury, 

and that glutamate was being taken up. Further, metabolism of glioma cells was higher 

than that of astrocytes, even with lower gliomas seeding density because the glioma cells 

have higher proliferation ability than astrocytes.   
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Next, the contribution of Na+ -dependent transporters was examined for glutamate 

uptake. Sodium-dependent transporters were blocked by substituting choline for sodium 

in Locke’s solution. An inverted microscope was used to examine changes in the 

morphology of astrocytes after the media was replaced with Locke’s solution with and 

without sodium. Locke’s solution with sodium chloride was used as the solution for 

sodium-containing media whereas choline chloride replaced sodium chloride for sodium-

free media. Figure 4.7 shows microscopic images of 3 days old astrocyte cells after 

placing them in the solution containing sodium and sodium-free media and incubated at 

37°C and 5% CO2 for 5 hr.  

 

 
a)     b)        c) 

 

 

Figure 4.7: 5k/well normal brain astrocytes a) Control (Astrocyte medium), b) LKS 

(sodium chloride), c) LKS (choline chloride) at 3 days in vitro (div) post 5 hr after 

replacement of complete astrocyte media. Scale bar: 100 um.  

 

 

 

Morphological changes in the cells after replacement of complete astrocyte 

medium with solution containing sodium and sodium-free media for 5 hr indicated cell 

stress. The cell bodies shrunk as they were exposed to prolonged incubation with Locke’s 

solution with and without sodium. 
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4.4 Conclusion and Discussion 

The morphology of both normal brain astrocytes and brain tumor cells from 

microscopic images captured before and after preincubation of 100 uM glutamate for 5 hr 

suggests no signs of cell stress. The glutamate uptake by normal brain astrocytes was 

density dependent. As the number of normal brain astrocytes increased, the percentage of 

glutamate uptake escalated. It has been reported that the presence of GLAST on the cell 

surface of astrocytes increases the number of glutamate binding sites thereby speeding up 

the glutamate uptake [76]. 

Extracellular glutamate uptake was much smaller for glioma cells than for normal 

brain astrocytes. Results indicated that these type of glioma cells have minimum or no 

glutamate clearing capacity from the extracellular environment. This result was consistent 

with the findings as reported by Ye et al. [111], however, there was no glutamate release 

by glioma cells from our experiments. This might be due to the variation in glioma cell 

lines used by different research laboratories. As observed from the results from this study 

and from the previous chapter, it was concluded that tumor invasion is not necessarily 

linked with release of glutamate from gliomas. The impaired uptake of glutamate by 

glioma cells could be caused by mislocalization of glutamate transporters in cell nuclei. 

Moreover, co-culture of glioma cells with astrocytes showed enhanced uptake of 

glutamate by astrocytes as compared with uptake by astrocytes alone. The presence of 

glioma cells in a co-culture model may thus cause astrocytes work harder. 

Glutamate tended to slightly increase the metabolism of cells. While the 

metabolism for glioma cells increased, astrocyte metabolism decreased, even though the 

density of astrocytes was more than glioma cells. Numerous studies have reported that 
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GLAST and GLT-1 are the major Na dependent transporters in astrocytes. Thus, 

complete media in astrocytes was replaced with Locke’s solution with and without 

sodium. Interestingly, cell stress was observed in both conditions. The hypothesis for 

contribution of Na+ -dependent transporters for glutamate uptake was tested, however, 

large changes in morphology of the cells prevented the results from being conclusive. 
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CHAPTER 5 

 

APPROACHES FOR MODIFICATION OF BRAIN CELLS USING 

ENGINEERED MICRO/ NANOMATERIALS 
 

5.1 Introduction 

Many remarkable developments have been made in the field of micro- and 

nanotechnologies in the last few decades. The advances in micro- and nanotechnologies 

are expected to open new possibilities and applications in tissue engineering and drug 

delivery [113]. Apoptosis plays an important role in the developmental process of an 

organism. Apoptosis can be used as a tool for cell patterning to alter the tissue shape 

[114], [115]. A possible method by which to modulate apoptosis, and hence the 

morphological characteristics of brain cells is to use nanofilms created from materials 

such as copper nanoparticles (CuNps) and staurosporine (STS). STS is a non-specific 

protein kinase inhibitor which acts as a potent apoptotic stimulus [116]. These 

approaches will provide a better understanding on modifying the brain 

microenvironment.  

Another method of changing the brain cell microenvironment is use of halloysite 

nanotubes (HNTs) as nanocontainers. Halloysite nanotubes are the aluminosilicate clay, 

chemically similar to kaolin, and found naturally in the earth in abundant quantities 

[117]. These nanotubes have outer diameter 50 ± 5 nm; inner lumen 10 - 15 nm; and 

length 1200 ± 300 nm. The outer surface of HNTs is composed of SiO2 (negative charge) 
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and the inner core is composed of Al2O3 (positive charge). The hollow lumens of 

halloysites can load and then provide sustained release of biomacromolecules such as 

proteins, DNA, drugs, and antibacterial agents. As an example, they have been studied 

for delivery of the poorly soluble drug camptothecin, an anticancer drug, that is capable 

of causing apoptosis but that has been underutilized because it is poorly soluble in water 

[118]. In the current study, camptothecin (CPT) was loaded in the hollow lumen of 

HNTs, encapsulated them with natural polyelectrolytes using layer-by-layer (LbL) 

assembly and delivered them to glioma cells. In this experiment, engineered micro/ 

nanomaterials CuNps, STS, and HNTs were used to modify the behavior of brain cells. 

5.2 Materials and Methods 

5.2.1 Creating Nanofilms 

Nanofilms were fabricated in the center of a 24-well cell culture plate (Griener).  

Prior to fabrication, the center of the well was marked with a sharpie from the bottom of 

the well plate. Nanofilms were created by dropping 20 uL volume of nanomaterials such 

as CuNps and STS in the marked area and they were baked for 6 h at 37 °C in a laboratory 

oven (Quincy Lab, Inc, Model 10). After baking, the plates were stored in room 

temperature until cells were plated. 

5.2.2 Chemicals 

To create nanofilms, chemicals such as CuNps and STS were obtained from 

Sigma-Aldrich. For drug delivery, halloysite nanotubes were obtained from Henan 

Province of China. Camptothecin was obtained from MP Biomedicals, LLC, Santa Ana, 

California, USA, and dissolved in dimethyl sulfoxide (DMSO). Polyelectrolytes used in 

this study diethyl aminoethyl ethyl dextran (DEAE dextran), sodium alginate, poly-l-
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lysine-block-co-polymer with polyethylene glycol (PLB), and Fluorescein 

isothiocyanate-PAH were purchased from Sigma-Aldrich. Other components used for 

this study such as DAPI (4',6-Diamidino-2-Phenylindole, Dihydrochloride), MTT were 

also purchased from Sigma Aldrich. All chemicals were used without any further 

processing. LUDOX TM 40 silica nanoparticles of diameter 5 nm were used to visualize 

polymer coating on halloysite nanotubes.  

5.2.3 Preparation of Halloysite Drug Composites 

12.5 mg of camptothecin were dissolved in 1 mL of DMSO to obtain saturated 

solutions. 25 mg of halloysite was added to this solution and mixed to obtain a 

homogeneous suspension. Aggregates were removed by sonicating for 5-10 min. The 

suspension was placed in vacuum for three 1 hr cycles, and then overnight to ensure 

maximum loading. The sample was removed and washed with ethanol to remove excess 

drug adsorbed. The sample was dried in a vacuum desiccator overnight and powdered. 

Drug loading efficiency was determined using thermogravimetric analysis. 

5.2.4 LbL Assembly on Halloysite 

2 mg/mL concentration of halloysite loaded with camptothecin was prepared in 

phosphate buffer saline (PBS). It was properly dispersed by sonicating for 5-10 min. Stock 

concentration of 30 mg/mL of DEAE Dextran, sodium alginate and PLB were individually 

prepared. The required amount of each polyelectrolyte was added to the halloysite mixture. 

It was then sonicated for 5 min and the zeta potential was measured to confirm complete 

charge reversal. No washing step was done after each layer was added, except for the last 

layer of PLB at 7000 rpm for 3 min. 
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5.2.5 Cell Culture 

To testing the nanofilms, microglia (CRL-3265) were obtained from American 

Type Culture Collection (ATCC) and cultured in microglia media (Appendix A, Section 

A.3). Cells were placed on top of the baked nanofilms. For drug delivery tests, rat brain 

glioma cells (CRL-2303) were obtained from ATCC and cultured in CRL-2303 media 

(Appendix A, Section A.1). Cells were plated at a density of 10,000 cells per mL onto a 

24-well cell culture plate and grown in an incubator at 37 ℃ in 5% CO2. After two days, 

the cells were treated with various concentrations (1-5 ug/mL) of free drug (CPT) or 

layer-by-layer coated halloysites loaded with camptothecin. Morphological studies were 

carried out at 24 hr and 96 hr timepoints. MTT assay was performed each day until 192 

hr. The cell culture media was not replenished during the entire experiment.  

5.2.6 Microscopy 

HNTs were imaged with both Scanning Electron Microscope (SEM) and 

Transmission Electron Microscope (TEM). Cells were imaged with light microscopy. 

The dried samples, prepared on silicon wafer, were gold sputter coated at 15mA for a 

thickness of ~10 nm and the nanotubes were observed under SEM, at 3 KV. Then, silica 

nanoparticles were coated on polyelectrolyte coated halloysite and, a diluted HNT 

suspension was placed onto formvar-coated copper grids (Agar), left to evaporate, and 

imaged with TEM at 120 V accelerating voltage. The microscopic images of cells were 

obtained with Leica DMI 6000B, captured every 24 hr after the cells were treated with 

samples to compare the morphological changes with the results from biochemical assays.  

5.2.7 MTT Assay 

The MTT assay has been described in Section 4.2.4.  
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5.3 Results 

5.3.1 Creating Nanofilms  

Nanofilms were created by dropping 20 uL volume of CuNps or STS in the 

marked area and baked for 6 h at 37 °C in a laboratory oven. Figure 5.1 shows the drying 

pattern of CuNps under the inverted microscope. 

 

 

 

Figure 5.1: Drying pattern of 100 ug/mL CuNps nanofilms after baking for 6 hr. Red 

arrows indicate aggregates of copper nanoparticles. Scale bar = 50 um. 

 

 

 

Since nanoparticles have very high surface area to volume ratio, nanofilms made 

of CuNps showed some agglomeration. Nanofilms made of STS were clear in color. After 

baking, microglia cells were placed on top of these nanofilms. 

5.3.2 Effect of Nanofilms on Cells 

Figure 5.2 shows phase contrast microscopy of microglia cells after they were 

seeded on top of the nanofilms created with 100 ug/mL copper nanoparticles or three 

concentrations of STS (500 nM, 1 uM, and 2 uM) at three timepoints (4, 24, and 48 hr). 
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Figure 5.2: Representative images of microglia cells after they were seeded on top of the 

nanofilms created with 100 ug/mL CuNps or various concentrations of STS (500 nM, 1 

uM, and 2 uM). The images were obtained using phase contrast microscopy at 4, 24, and 

48 hr respectively. Scale bar = 50 um. 

 

 

 

At 4 hr timepoint, the copper nanoparticles were still evident (Figure 5.2, second 

row) whereas they start clearing up after 24 hr and completely disappear at 48 hr. The 
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cells became more circular with no processes and more clumped at 48 hr as compared to 

4 hr timepoint. The morphological differences are more pronounced for microglia cells 

treated with 1 uM and 2 uM STS as compared to the control at 4 hr. Cells treated with 

500 nM STS exhibit few, relatively short but thick extensions at 24 hr but the processes 

disappear at 48 hr. In contrast, cells treated with 1 uM and 2 uM STS have large and thin 

processes with a branch-like appearance at all timepoints. 

Figure 5.3 shows the phase contrast and fluorescence images of DAPI-stained 

nuclei of the cells treated with nanofilms made of control (water), 100 ug/mL CuNps, 500 

nM STS, 1 uM STS, and 2 uM STS. The number of nuclei decreased dramatically in the 

cells treated with 100 ug/mL CuNps and the cells were clumped after 72 hr as compared 

to the control. Treatment with 500 nM STS slightly decreased the number of cells, 

whereas treatment with 1 and 2 uM STS decreased the number of cells dramatically. 

However, cells treated with STS exhibited no clumping. 
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Figure 5.3: Phase contrast and fluorescence images of microglia after DAPI staining at 72 

hr. 20,000 cells/mL were plated after creating nanofilms with 100 ug/mL CuNps (positive 

control) and different concentrations of STS (500 nM, 1 uM, and 2 uM). Scale bar = 50 

um. 
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Table 5.1 shows the data obtained from the analysis of total number of objects, 

average area, average roundness, and NAF for microglial cells treated with nanofilms 

made of CuNps and various concentrations of STS after the nuclei were stained with 

DAPI. The total number of objects was the highest in the control. Although the total 

number of objects treated with 100 ug/mL CuNps was the least of all the conditions 

tested, the average area of the cells was relatively high. It was hypothesized that the cells 

treated with CuNps undergo necrosis, thereby causing an increase in cellular area. As a 

result, NAF increased, and higher NAF is an indicator of necrosis. NAF is given by the 

product of the average area and the average roundness of nuclei [99]. The number of 

objects decreased significantly when the cells were treated with 1 uM STS and 2 uM STS 

as compared to 500 nM STS. As the concentration of STS increased, the average area 

covered by the cells decreased. However, the roundness of nuclei did not change 

noticeably, although the morphology of the cells changed drastically with higher 

concentration of STS as mentioned earlier. NAF decreased in all three concentrations of 

STS as compared to control and 100 ug/mL CuNps. Thus, it can be concluded that STS 

induced apoptosis to the cells as NAF goes down during apoptosis.   
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Table 5.1: Analysis of total number of objects, average area, average roundness, and 

Nuclear Area Factor (NAF) (n = 6) for microglial cells treated with nanofilms made of 

CuNps and various concentrations of STS. 

 

 
 

 

 

5.3.3 Drug Delivery Using Halloysite Nanotubes  

LbL-coated halloysite nanotubes were loaded with camptothecin in collaboration 

with Dr. Lvov’s lab at Louisiana Tech University. Figure 5.4 A-B shows the schematic 

of halloysite nanotubes depicting their characteristics and dimensions. Figure 5.4 C-D 

shows the SEM and TEM images of halloysite nanotubes.  
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Figure 5.4: (A-B) Schematic of halloysite nanotube depicting characteristics and 

dimensions of halloysite nanotubes (C) SEM image of halloysite nanotubes (D) TEM 

image of halloysite nanotubes. 

 

 

 

Figure 5.5 shows the schematics illustrating the loading of camptothecin inside 

the lumen of halloysite nanotubes followed by deposition of natural polyelectrolytes and 

FITC using layer-by-layer (LbL) technique and delivering them to brain tumor cells 

(CRL-2303). 

 

 

 

Figure 5.5: Schematics illustrating the loading of camptothecin inside the lumen of 

halloysite nanotubes followed by deposition of natural polyelectrolytes and FITC using 

layer-by-layer (LbL) technique and delivering them to brain tumor cells (CRL-2303). 
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Each polyelectrolyte (PE) was added using a non-washing method by slowly 

titrating the required amount for complete charge reversal. The alternation of positive and 

negative values of zeta potential confirms the shell formation on the surface of halloysite. 

Surface charge of ±15 mV or above but below 40 mV is considered as complete charge 

reversal. To make the tracking of halloysite nanotubes easier, FITC-PAH was added as 

first layer to aid in fluorescent imaging. Silica nano particles were diluted from a stock 

solution (5%) to prevent their coating in excess. A change in surface charge to negative 

was observed after the addition of silica.  

Alternation of negative and positive values of zeta potential confirm layer by 

layer assembly. Zeta potential measurements indicated a change in surface charge from -

30 mV in pristine halloysites to +23 mV in final cationic layer.  

Figure 5.6 shows the zeta potential values after the addition of each 

polyelectrolyte layer showing charge reversal. 

 

 
 

 

Figure 5.6: Zeta potential values after the addition of each polyelectrolyte layer showing 

charge reversal. 
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To demonstrate that the halloysite nanotubes are concentrated in or on cancer 

cells, HNTs coated with natural polyelectrolytes labelled with FITC were visualized 

under fluorescent microscope.  Further, the nuclei of cancer cells were stained with 

DAPI, a fluorescent dye. The photomicrographs of FITC labelled HNTs coated with 

natural polyelectrolytes were merged with DAPI-stained nuclei and it was evident that 

the halloysites were present in or on cancer cells as shown in Figure 5.7. The FITC was 

very near the DAPI, and the FITC labelled halloysites were intact despite various 

washing/staining steps. 
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Figure 5.7: FITC labelled HNTs coated with natural polyelectrolytes (5 ug/mL); DAPI 

staining of CRL-2303; Merged image of FITC and DAPI shows localization of HNTs in 

or on the nuclei. Images were taken 120 hr after addition of FITC labelled HNTs coated 

with natural polyelectrolytes to CRL-2303 cells. Scale bar = 50 um. 

 

 

 

Cell morphological changes were studied after microscopic pictures were 

captured for 96 hr. Figures 5.8and 5.9show that the cells treated with both concentrations 

of bare HNT continued to grow and proliferate until 96 hr, whereas growth of cells 

treated with CPT, HNT-CPT, Nat LbL HNT-CPT was inhibitted.  
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Figure 5.8: Effect of 1 ug/mL concentration of HNT, CPT, HNT-CPT, and Nat LbL HNT-

CPT on CRL-2303 cells after 24 hr (top) and 96 hr (bottom). Images shown are 

representatives of multiple wells (n = 3) and multiple platings of cells for each condition 

tested. Scale bar = 100 um. 

 

 

 

 
 

 

Figure 5.9: Effect of 5 ug/mL concentration of HNT, CPT, HNT-CPT, and Nat LbL 

HNT-CPT on CRL-2303 cells after 24 hr (top) and 96 hr (bottom). Images shown are 

representatives of multiple wells (n = 3) and multiple platings of cells for each condition 

tested. Scale bar = 100 um. 

 

 

 

Figure 5.10 shows the viability assay demonstrating the long-term sustained 

release of anticancer drug (camptothecin) from encapsulated HNTs coated with natural 

polyelectrolytes using LbL technique in glioma cells. Cells treated with HNT decreased 
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sharply after 120 hr. This downturn was because the cells reach confluency and they 

begin to rip off from the cell culture plate as the media was not replenished. Cells treated 

with free drug (CPT) fail to suppress the activity of cancer cells and the cells try to 

bounce back. However, in comparison to CPT, Nat LbL HNT-CPT at submaximal killing 

concentrations (1 ug/mL) sustained suppression of glioma cell growth in vitro after the 

initial burst of inhibition. 

 

 

 
 

 

Figure 5.10: Viability assay of the long-term sustained release of anticancer drug 

(camptothecin) from encapsulated HNTs coated with natural polyelectrolytes using LbL 

technique in glioma cells.  
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5.4 Conclusions 

Cell patterning can be achieved by inducing apoptosis as it modifies the 

morphological characteristics of brain cells. Here, engineered micro/ nanomaterials such 

as nanofilms created from CuNps and STS were used to modify brain cells. The 

nanofilms developed in this project allow to create boundaries, thus eliminating the need 

to work with the entire well as opposed to working with soluble drugs. These approaches 

will provide with a better understanding to change the brain microenvironment. From the 

calculations of NAF, we concluded that positive control (CuNps) used in this experiment 

caused cell death by necrosis whereas STS caused cell death by apoptosis.  

Another example to change the brain cell microenvironment is using halloysite 

nanotubes as nanocontainers for delivery of the poorly soluble drug camptothecin. 

Camptothecin, an anti-cancer drug, can be loaded into the hollow nanotubes, and 

delivered to cancer cells. Results showed that the surface of halloysite nanotubes can be 

modified using natural polyelectrolytes. In vitro studies in cancer cells further verified 

that the camptothecin loaded LbL coated halloysite nanotubes show great potential for 

long-term release of drugs.  
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CHAPTER 6 

 

POTENTIAL APPLICATIONS OF COPPER CONTAINING HIGH 

ASPECT RATIO STRUCTURES (CUHARS) FOR BIOMEDICAL 

PURPOSES 
 

6.1 Introduction 

In this chapter, the potential applications of a novel biohybrid material discovered 

in Dr. Decoster’s laboratory at Louisiana Tech University which was named Copper 

containing High Aspect Ratio Structures (CuHARS) will be studied. CuHARS consist of 

copper and an amino acid cystine [120], and they are assembled using a bottom up 

approach in aqueous solution under physiological conditions [121].  

Cellulose, the most abundant polysaccharide on earth, are used as scaffolds for 

tissue engineering, in vitro testing of cell models and for other medical purposes [122], 

[123]. Here, incorporation of CuHARS into cellulose was demonstrated to construct 

stable matrix for CuHARS delivery in glioma cells. Additionally, magnetically 

susceptible materials such as iron oxide nanoparticles (Fe2O3NPs) with CuHARS-

cellulose matrix was used to spatially control CuHARS delivery.  

Recently, a technique to break down CuHARS using sonication was developed, 

thus obtaining uniform sized CuHARS with nano-features. The interaction of sonicated 

CuHARS was tested in the co-culture model that we developed earlier. It was 

hypothesized that sonicated CuHARS are non-toxic to cells. Furthermore, degradation of 
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CuHARS was demonstrated for the first time in a co-culture model consisting of glioma 

cells and normal brain astrocytes. 

6.2 Materials and Methods 

6.2.1 Materials and Reagents 

Whatman filters (grade-1) 32 mm with 11 um pores were obtained from VWR. 

TEMPO (2,2,6,6-tetramethylpiperidine-1-oxyl (98%), sodium bromide, sodium 

hypochlorite (reagent grade, available chlorine 10-15%), Fe2O3NPs (<50 nm), copper 

sulfate, cystine, and NaOH were from Sigma-Aldrich (St. Louis, MO, USA).   

6.2.2 Sonication of CuHARS 

CuHARS were synthesized with copper sulfate as starting material and cystine as 

the amino acid [120], [124]. Synthesis was carried out in liquid under biological 

conditions (37 °C) and the composites are formed by self-assembly process. Synthesized 

CuHARS mixtures were transferred to 0.65 mL microcentrifuge tubes (VWR, Catalog 

number 87003-290). They were sonicated for 20 min in Branson 1510 ultrasonic cleaner.   

6.2.3 Generation of Cellulose Films and Cellulose Hybrid Materials 

Cellulose fibers were obtained by TEMPO mediated oxidation from Whatman 

filters following the procedure described by Saito et al. [125]. Briefly, the filters (1 g) 

were suspended in 100 mL of water and converted into a pulp using a domestic blender, 

and then 16 mg of TEMPO and 100 mg of sodium bromide were added to the pulp under 

magnetic stirring at 400 rpm. The TEMPO mediated oxidation was started by adding 9 

mL of sodium hypochlorite solution dropwise and the pH was maintained at 10 by adding 

0.5 M NaOH solution. The process was maintained for 4 hr. The TEMPO-oxidized 

cellulose fibers were then centrifuged at 9,000×g relative centrifugal force (rcf) for 4 min. 



91 

The resulting fibers were resuspended in water and centrifuged as above as a washing 

step and this process was repeated twice. Next, the fibers were resuspended in water to a 

concentration of around 0.4% w/v, and blended for about 1 hr to produce the mechanical 

defibrillation of the cellulose pulp. Finally, the suspension was centrifuged at 2,000 rcf 

for 4 min to remove the thicker fibers. After this process, the final concentration of the 

suspension was 0.3% w/v. The cellulose suspension was stored at 4° C before further 

experiments were carried out. The carboxyl content was determined by means of 

conductometric titration with 0.04 M NaOH, using a Pt conductivity cell 50-70 and GLP 

31 conductivity meter from Crison, and it was found to be 1.41 mmol carboxylic groups 

per gram of cellulose.        

The biohybrid cellulose/nanoparticles films were prepared by mixing the cellulose 

fibers dispersion with diverse nanomaterials to construct solid biohybrid films by simple 

casting and drying. Cellulose/CuHARS materials were prepared by dispersing 0.5 mL of 

a 1 mg/mL CuHARS solution in 4 mL of 0.3% w/v cellulose suspension. The mixture 

was vortexed for homogenization, and 4 mL of this liquid mixture was then placed/well 

in one or more of the wells of a 12-well suspension plate (Greiner) and dried in the oven 

at 37° C for 48 hr to produce cellulose/CuHARS biohybrid films. The content of 

CuHARS nano- and micro-materials in the films is about 4% of the total mass. Similarly, 

cellulose/CuHARS/Fe2O3 materials were prepared by addition of 0.5 mL of previously 

sonicated Fe2O3 nanoparticles (1 mg/mL solution) together with the CuHARS into the 

cellulose dispersion. In this case, the films were loaded with 3.8% CuHARS and 3.8% 

Fe2O3 nanoparticles with respect to the total mass. 
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6.2.4 Cell Culture 

CRL-2303 glioma cells were plated at 20,000 cells/well on a 24-well cell culture 

plates. Cells were allowed to attach to well plates and were incubated for up to 74 h under 

physiological conditions in 37 °C, 5% CO2, humidified incubators. The stability of 

constructed cellulose-CuHARS matrix was tested in these cells. For degradation studies, 

a co-culture experimental model was developed as described in Chapter 3. 

6.2.5 Digital Microscopy Imaging 

All images were obtained using a Leica DMI 6000B inverted microscope. Since 

the cellulose matrix biofilms were slightly above the Z-axis focal plane compared to the 

underlying cell culture area, images shown for matrix cell interactions were composed by 

carrying out a digital overlay function using Adobe Photoshop (Version 6.0.1). One 

digital image focused at the Z-plane of the cellulose matrix, and another digital image 

focused at the plane of the cells were combined by digital overlay.  

6.2.6 Image Analysis 

The software Image Pro-Plus version 7.0, developed by Media Cybernetics, was 

used for image analysis. Histograms were created to analyze the size distribution of 

different concentrations of CuHARS at various timepoints. 

6.3 Results 

6.3.1 Integration of CuHARS with Cellulose and Magnetic Susceptible 

Nanoparticles  

CuHARS and Fe2O3NPs were incorporated into porous, non-degradable cellulose 

to further spatially control CuHARS delivery and CuHARS density in two and three 

dimensions. CuHARS-cellulose matrices were constructed using a liquid/pulp phase, and 
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then dried them into stable, solid films which could be easily handled (Figure 6.1 a). 

Furthermore, biohybrids of the cellulose matrix that incorporate both Fe2O3NPs and 

CuHARS remained magnetically susceptible to a permanent bar magnet for at least 8 

months after the fabrication of the material (Figure 6.1 b). 

 

  

 

 

 

Figure 6.1: Panel (a) Cellulose matrix at the macroscale, showing from left to right, 

cellulose biohybrids incorporating CuHARS, Fe2O3NPs/CuHARS, and cellulose alone, 

respectively. The 3rd sample (rightmost sample) is a fragment of the constructed cellulose 

matrix alone. Metric scale below the matrix discs indicates diameter of approximately 2 

cm for each disc. Panel (b) Cellulose matrix sample incorporating susceptible 

Fe2O3NPs/CuHARS suspended by a permanent bar magnet. 
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Microscopic digital imaging of the constructed biohybrid cellulose matrices 

demonstrated curved, more transparent cellulose fibers integrated with straight, dark 

high-aspect ratio structures which were identified as the CuHARS component. As 

previously shown [101], the contrast provided by the copper component of CuHARS 

causes the material to stand out well against white light backgrounds. This contrast was 

confirmed in the current work upon integrating CuHARS into cellulose matrices, which 

were sufficiently thin to pass light, and reveal both cellulose fibers and the straight, dark 

contrasting CuHARS components as shown in Figure 6.2. Although cellulose nanofibers 

that produce highly transparent films were not used, the type of cellulose used in this 

work gives rise to films with a sufficient degree of transparency for visualization using 

inverted white light microscopy. A 0.1% suspension of this cellulose shows a 

transmittance of around 30% at 600 nm due to light scattering, as it is composed of a 

mixture of micro- and nano-fibers (data not shown). Nevertheless, its preparation has the 

advantage of being less time and energy consuming than for nanofibers, and it gives rise 

to films with enough quality. 

 

 
 

 

Figure 6.2: Incorporation of cellulose with CuHARS. Blue arrows indicate CuHARS 

(dark and straight structures), and yellow arrowheads indicate cellulose fibers (light, 

curved structures). Image obtained using inverted light microscopy. Scale bar = 50 um.   
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6.3.2 Application of Constructed Cellulose Materials to Aqueous Solutions 

The stability of constructed cellulose materials for potential environmental and 

biomedical applications in aqueous environments was tested by placing pieces of 

constructed films into water and cell culture media. Films were successfully constructed 

that provided sufficient porosity for the materials to be wettable and easily immersible in 

the liquid of interest (non-floating). The stability of constructed films in aqueous 

environments led to next test if the CuHARS-cellulose and other constructed films were 

compatible with in vitro cell culture systems. As shown in Figure 6.3, fast-growing brain 

tumor cells were used as a model for assessment, and they demonstrated that constructed 

films could be placed within cell culture plates for testing purposes. Since the cellulose 

films are easily wettable, but still somewhat mobile within the media-containing wells, 

the cut pieces of film still move around to some extent. Additionally, since the films 

settle on top of the cells, images were constructed from these in vitro experiments by 

digitally overlaying the Z-plane of focus for the films with the Z-plane focus for the cells, 

for the same field of view for a given image (Figures 6.3, 6.4, and 6.5).     
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Figure 6.3: Cellulose films testing with cells in defined microenvironments. Cellulose 

matrix materials alone were tested for compatibility with cell culture conditions. The 

bottom portion of the image shows the cellulose matrix and top portion shows brain 

tumor cells. Blue arrowheads indicate cellulose fibers and stars indicate edges of glioma 

cells. Scale bar = 50 um. 

 

 

 

 

 

Figure 6.4: Cellulose films testing with cells in defined microenvironments. Cellulose-

CuHARS biohybrids. The bottom portion shows the cellulose-CuHARS matrix and the 

top portion shows glioma cells with some released CuHARS. To evaluate integration into 

the matrix of smaller size biohybrids, CuHARS were sonicated as previously described 

[120] before they were combined with cellulose. White arrows indicate CuHARS and 

stars indicate edges of glioma cells. Scale bar = 50 um. 
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Figure 6.5: Cellulose-CuHARS-Fe2O3NPs biohybrids. Bottom portion shows the 

cellulose-CuHARS-Fe2O3NPs matrix and top portion shows glioma cells with some 

released CuHARS. For these integrated hybrids, CuHARS were not sonicated before 

mixing with cellulose. Therefore, some very long CuHARS were successfully integrated 

into the cellulose matrix, as indicated. Blue arrows indicate CuHARS and stars indicate 

edges of glioma cells. Scale bar = 50 um. 

 

 

 

6.3.3 Cellular Interaction of Sonicated CuHARS in a Co-culture Model 

Sonicated CuHARS were tested for their toxicity and degradation in the co-

culture model developed earlier. Figures 6.6 - 6.11 are the microscopy images of 

interaction of co-culture with 1 ug/mL, 5 ug/mL, and 10 ug/mL sonicated CuHARS 

respectively. Images using bright field microscopy were obtained because the copper 

component of CuHARS stands out well and it is easier for image analysis. Morphological 

changes in cells were viewed in images taken using phase contrast microscopy.  

Figure 6.6 shows phase contrast microscopy images from a co-culture of normal 

brain astrocytes and glioma cells over 72-hr timepoint. The microscopic images of 

control cells show proliferation over time and the cells appear to be healthy. 
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Figure 6.6: Phase contrast microscopy images of a co-culture experimental model with 

1:3 ratio of glioma cells and normal brain astrocytes at 3, 24, 48, and 72 hr timepoints. 

Scale bar = 100 um. 

 

 

 

Figure 6.7 shows phase contrast images in a co-culture experimental model with 

1 ug/mL sonicated CuHARS. No obvious morphological differences are apparent 

between this figure and Figure 6.6, without CuHARS.  
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Figure 6.7: Phase contrast microscopy image of a co-culture of normal brain astrocytes 

and glioma cells with 1 ug/mL concentration of sonicated CuHARS at 3, 24, 48, and 72 

hr timepoints. Scale bar = 100 um. 

 

 

 

The co-culture with 1 ug/mL CuHARS is also shown in brightfield as shown in 

Figure 6.8. The CuHARS were evenly distributed throughout the wells and they 

degraded slowly over time. No clumping of sonicated CuHARS was noticed at any of the 

timepoints in 72 hr period. 
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Figure 6.8: Bright field microscopy image of a co-culture of normal brain astrocytes and 

glioma cells with 1 ug/mL concentration of sonicated CuHARS (yellow arrows) at 3, 24, 

48, and 72 hr timepoints. Scale bar = 100 um. 

 

 

 

Figure 6.9 shows phase contrast images in a co-culture experimental model with 

the concentration of sonicated CuHARS increased to 5 ug/mL. 
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Figure 6.9: Phase contrast microscopy image of a co-culture of normal brain astrocytes 

and glioma cells with 5 ug/mL concentration of sonicated CuHARS at 3, 24, 48, and 72 

hr timepoints. Scale bar = 100 um. 

 

 

 

The brightfield images for the co-culture experiment with 5 ug/mL CuHARS is 

shown in Figure 6.10. 
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Figure 6.10: Bright field microscopy image of a co-culture of normal brain astrocytes 

and glioma cells with 5 ug/mL concentration of sonicated CuHARS (yellow arrows) at 3, 

24, 48, and 72 hr timepoints. Scale bar = 100 um. 

 

 

 

Figure 6.11 shows phase contrast images in a co-culture experimental model with 

the concentration of sonicated CuHARS increased to 10 ug/mL. At 72 hr, the area 

coverage by cells was less than it was at the other concentrations of sonicated CuHARS, 

indicating that high concentrations of CuHARS could be toxic to cells. 
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Figure 6.11: Phase contrast microscopy image of a co-culture of normal brain astrocytes 

and glioma cells with 10 ug/mL concentration of sonicated CuHARS at 3, 24, 48, and 72 

hr timepoints. Scale bar = 100 um. 

 

 

 

Figure 6.12 shows bright field images in a co-culture experimental model with 

the concentration of sonicated CuHARS at 10 ug/mL. 

CuHARS were mostly seen in the areas with no cells at 3 hr with a little 

clumping, but at 48 hr clumping was seen, mostly on the cells. CuHARS degraded slowly 

from 24 hr to 72 hr. 
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Figure 6.12: Bright field microscopy image of a co-culture of normal brain astrocytes 

and glioma cells with 10 ug/mL concentration of sonicated CuHARS (yellow arrows) at 

3, 24, 48, and 72 hr timepoints. Scale bar = 100 um. 

 

 

 Figure 6.13 shows the bar graph of total area covered by 1 ug/mL, 5 ug/mL, and 

10 ug/mL sonicated CuHARS at 3, 24, 48, and 72 hr timepoints. The total area covered 

by CuHARS for all the concentrations decreases at 3, 24, 48, and 72 hr which suggests 

that CuHARS degrades over time. At 1 ug/mL of sonicated CuHARS the area coverage 

at 3 hr was 1693 um2 and it did not change significantly at 24 hr. However, it decreased 

by 50% at 48 hr and by about 80% at 72 hr. At 5 ug/mL sonicated CuHARS the area 

covered at 3 hr was 15,177 um2 and it dropped to 56% of this value at 24 hr. It further 

decreased to about 10% of this value at 72 hr. At 10 ug/mL sonicated CuHARS, the area 
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coverage at 3 hr was 28,588 um2 whereas it decreased to about 19% of this value by 48 hr 

and then to 5.6% of this value at 72 hr, where it was nearly the same as the 5 ug/mL case 

at the same time point. Hence, it can be concluded that the degradation of CuHARS does 

not slow down even though the concentration increases at 48 and 72 hr. 

 

 

 

 

Figure 6.13: Total area covered by 1, 5, and 10 ug/mL sonicated CuHARS at 3, 24, 48, 

and 72 hr timepoints. 

 

 

Figure 6.14 shows the total number of objects covered by 1, 5, and 10 ug/mL 

sonicated CuHARS at 3, 24, 48, and 72 hr timepoints. The total number of CuHARS for 

all the concentrations tested decreases progressively from 3 to 72 hr, which further 

supports that CuHARS degrades over time. For 1 ug/mL sonicated CuHARS, the total 

number of objects was 221 at 3 hr and it dropped to 86%, 56% and 26% of this initial 

value at 24, 48, and 72 hr, respectively. For 5 ug/mL sonicated CuHARS was more than 

four times the total number for 1 ug/mL at 3 hr. The number of objects in 5 ug/mL 



106 

sonicated CuHARS dropped to 24% of this original value at 72 hr. For 10 ug/mL 

sonicated CuHARS the number was seven times the value for 1 ug/mL at 3 hr. It dropped 

to 14% of its 3 hr value at 72 hr. 

 

 

Figure 6.14: Total number of objects covered by 1, 5, and 10ug/mL sonicated CuHARS 

at 3, 24, 48, and 72 hr timepoints.  

 

 

 

The size distribution for 1 ug/mL sonicated CuHARS at 3 24, 48, and 72 hr are as 

shown in Figure 6.15. Most of the CuHARS ranged from 6-12 um in length whereas a 

few of them were as large as 13-33 um at 3 hr. At 24 and 48 hr timepoints, CuHARS 

larger than or equivalent to 20 um disappeared which suggests that CuHARS are 

degrading over time. However, only few CuHARS remained until 72 hr and they ranged 

from 3-13 um. 
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Figure 6.15: Size distribution of 1 ug/mL sonicated CuHARS at 3, 25, 48, and 72 hr. 

 

 

 

The size distribution for 5 ug/mL sonicated CuHARS at 3 24, 48, and 72 hr are as 

shown in Figure 6.16. Most of the CuHARS ranged from 3-13 um in length whereas a 

few of them were as large as 14-34 um at 3 hr. Some of the larger CuHARS disappeared 

at 24 hr which suggests that CuHARS was breaking down over time. At 48 hr timepoint, 

the size distribution for 3-4 um CuHARS increased and some of the CuHARS that ranged 

from 17-34 um disappeared which might indicate that the larger CuHARS are degrading 

and getting shorter while the smaller CuHARS are disappearing over time. However, a 

few of the CuHARS do not completely degrade at 72 hr but most of the CuHARS ranged 

from 3-10 um at 72 hr and a few ranged from 11-16 um. 
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Figure 6.16: Size distribution of 5 ug/mL sonicated CuHARS at 3, 24, 48, and 72 hr. 

 

 

 

The size distribution for 10 ug/mL sonicated CuHARS at 3 24, 48, and 72 hr are 

as shown in Figure 6.17. Most of the CuHARS ranged from 3-18 um in length whereas a 

few of them were as large as 19-52 um and some were over 55 um at 3 hr. At 24 hr 

compared to 3 hr, less CuHARS were from 5-18 um, which suggests that CuHARS was 

breaking down over time, which is consistent with our findings for 5 ug/mL sonicated 

CuHARS. At 48 hr timepoint, more CuHARS ranged from 3-5 um and some of the 

longer CuHARS disappeared. However, a few of the CuHARS do not completely 

degrade at 72 hr.  
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Figure 6.17: Size distribution of 10 ug/mL sonicated CuHARS at 3, 24, 48, and 72 hr. 

 

 

6.4 Conclusion and Discussion 

Initially, two major beneficial aspects were found for CuHARS integration with 

cellulose: 1) biohybrid sheets could be constructed that when dried, provided sufficient 

light penetration for effective imaging of materials by white light microscopy  

and 2) CuHARS-cellulose integrated materials were sufficiently wettable to interact with 

cells for initial in vitro testing).                  

For further proof of principle for comparative purposes with CuHARS, 

magnetically susceptible Fe2O3NPs were integrated into cellulose matrices. In the case of 

Fe2O3NPs, the generated material retained magnetic susceptibility for at least 8 months 

after fabrication with storage under dry, room temperature conditions. Due to the stability 

and scalability of CuHARS-cellulose matrices shown here and including incorporation of 
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additional functional materials such as Fe2O3NPs, environmental and sensor applications 

may be possible.  

CuHARS may be stably integrated into a matrix containing the natural product 

cellulose, forming a convenient biohybrid. The CuHARS-cellulose biohybrid composite 

may also be combined with magnetically susceptible materials such as Fe2O3NPs for 

further control of the materials. The generated cellulose matrix discs are sufficiently thin 

to pass light for white light microscopy imaging and are sufficiently wettable and 

compatible with cell culture media to permit interactions for in vitro testing purposes. 

Since CuHARS are completely (but slowly) degradable under physiological conditions, 

incorporation of CuHARS into cellulose matrices may extend degradation lifetimes for 

biomedical applications. 

The key considerations for any biomaterial include better understanding of 

degradation and how they interact with the cells. From this experiment, we observed that 

CuHARS interaction with cells is biphasic in the sense that it can promote cell growth at 

lower concentrations where as it can be toxic at high concentrations i.e. 10 ug/mL. 

Sonication breaks down CuHARS to more uniform size, thus causing them to exhibit the 

properties of nanomaterials such as agglomerating after 24 hr before degrading. 

However, 1 ug/mL sonicated CuHARS did not show any signs of clumping over the 72 

hr timepoint. Further, CuHARS can degrade over time. Lower concentrations of 

CuHARS (1 ug/mL and 5 ug/mL) have a greater number of materials concentrated 

towards shorter lengths and they start to disappear whereas high concentrations of 

CuHARS (10 ug/mL) have longer lengths at the early timepoint (3 hr and 24 hr) which 
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breaks down into smaller lengths before finally disappearing. However, some CuHARS 

do not completely degrade.  

Thus, potential applications of a novel biohybrid material CuHARS were 

explored for incorporation with cellulose and degradation of sonicated CuHARS was 

investigated. 
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CHAPTER 7 

 

CONCLUSIONS AND FUTURE WORK 
 

 

Astrocytes participate in various physiological and pathological conditions, and 

they are thought to influence tumor cell invasion and metastasis. In this dissertation, a co-

culture model consisting of normal brain astrocytes and gliomas was developed using a 

mixed co-culture method to achieve a stable system that mimics the brain tumor 

microenvironment. Further, strategies to distinguish the different cell populations in a co-

culture model was demonstrated. Understanding the complex interactions between the 

normal brain cells and brain tumor cells, and the relevance to tumor progression over 

time was achieved. Moreover, the co-culture model developed in this project provided a 

platform to study tumor microenvironment by overcoming the limitations between 

traditional monocultures and in vivo animal models. In most cases, anti-cancer drug 

treatments are tested on glioma cells only, but the co-culture model developed in this 

study consists of both astrocytes and glioma cells, representing a real case scenario. In 

future, the effect of anti-cancer drugs such as paclitaxel and doxorubicin can be studied in 

the co-culture model. Three-dimensional (3D) co-culture model can be developed in 

which the cells form aggregates or spheroids to bridge the gap between in vitro and in 

vivo models as well as resemble in vivo environment more closely than the two-

dimensional (2D) model. Glutamate uptake by normal brain astrocytes and glioma cells 

was density dependent. However, extracellular glutamate uptake by astrocytes was six-
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fold more compared to glioma cells. Results showed that uptake of glutamate by 

astrocytes in the presence of glioma cells was enhanced than the glutamate uptake by 

astrocytes alone. Inhibition of glutamate uptake may be linked to several pathological 

conditions. Using this co-culture system, therapeutic strategies for cancer emerging from 

astrocyte-tumor interaction can be developed. New technologies to measure real-time 

glutamate uptake in a co-culture model can be developed. 

Morphological characteristics of brain cells were modified using apoptosis 

inducer staurosporine and necrosis inducer copper nanoparticles.  

Figure 7.1 shows the schematic diagram of interaction of non-degradable and degradable 

biomaterials with brain cells and their outcome features. 

 

  

 

Figure 7.1: Schematic diagram of interaction of non-degradable and degradable 

biomaterials with brain cells and their outcome features. 
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While all the biomaterials have their own advantages and disadvantages, each 

material is chosen for their applications in the biomedical research. CuHARS are a 

degradable biomaterial whereas beads and halloysite nanotubes are non-degradable. 

Biomaterials can either be injected or implanted in the body with surgery. While the non-

degradable biomaterials require further surgery for removal, degradable biomaterials do 

not require a second surgical event for removal. CuHARS may be integrated with 

cellulose to construct matrices that can be used for long term experiments. These matrices 

can be further controlled in time and space by combining them with magnetically 

susceptible materials such as Fe2O3NPs. By incorporating CuHARS with cellulose 

matrices, CuHARS can be presented at defined densities and locations and then released 

in a controlled manner. This capability may provide a delayed action delivery platform to 

cells. CuHARS has attracted interest as it is degradable and can be integrated into a 

matrix, hence further surgery is not required to remove the scaffold after initial 

implantation surgery.  

 

 

 

 

 

 

 

 



115 

 

APPENDIX A  
 

CELL CULTURE MEDIA 
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A.1 CRL-2303 Media 

A.1.1 Materials Required for 250 mL Media  

• Sterile filtration unit 

• 221.25 mL Dulbecco’s Modified Eagle’s Medium (DMEM) 

• 25 mL Fetal Bovine Serum (FBS) (10 %) 

• 2.5 mL Amino acid solution (1 %) 

• 1.25 mL Penicillin/Streptomycin solution (P/S) (0.5 %) 

A.1.2 Preparation of CRL-2303 Growth Media  

The procedure is carried out in a laminar flow hood (sterile environment). 

1. Add 110.25 mL DMEM to sterile filtration unit. 

2. Add Fetal Bovine Serum, Amino acid solution, and P/S to sterile filtration unit. 

3. Add 111 mL DMEM to sterile filtration unit. 

4. Place the lid over sterile filtration unit and connect it to vacuum nozzle. 

5. Carefully turn on the vacuum and allow the liquid to pass through the filter. Make 

sure to hold sterile filtration unit during this step so the unit does not turn over. 

Turn off the vacuum before bubbles form. 

6. Twist top of filtration unit off carefully. Screw sterile cap onto container of 

media. 

7. Label media as CRL-2303 media with date and your initials, and store in 

refrigerator. 

A.2 Astrocyte Media 

A.2.1  Materials Required for 250 mL Media 

• Sterile filtration unit 
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• 223.75 mL Ham’s F-12K media with L-Glutamine 

• 12.5 mL Fetal Bovine Serum (FBS) (5.0 %) 

• 12.5 mL Horse Serum (5.0 %) 

• 1.25 mL Penicillin/Streptomycin solution (P/S) (0.5 %) 

A.2.2 Preparation of Astrocyte Growth Media  

The procedure is carried out in a laminar flow hood (sterile environment). 

1. Add 100 mL Ham’s F-12K media to sterile filtration unit. 

2. Add Fetal Bovine Serum, Horse Serum, and P/S to sterile filtration unit. 

3. Add 123.75 mL Ham’s F-12K media to sterile filtration unit. 

4. Place the lid over sterile filtration unit and connect it to vacuum nozzle. 

5. Carefully turn on the vacuum and allow the liquid to pass through the filter. Make 

sure to hold sterile filtration unit during this step so the unit does not turn over. 

Turn off the vacuum before bubbles form. 

6. Twist top of filtration unit off carefully. Screw sterile cap onto container of 

media. 

7. Label media as Astrocyte media with date and your initials, and store in 

refrigerator. 

A.3 Microglia Media 

A.3.1 Materials Required for 250 mL Media 

• 211.25 mL DMEM: F-12 

• 25 mL Heat-inactivated Fetal bovine serum (FBS) (10%)      

• 12.5 mL Heat-inactivated Horse Serum (HS) (5%)             

• 1.25 mL Penicillin/Streptomycin solution (P/S) (0.5 %)                                       
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A.3.2 Preparation of Microglia Growth Media  

The procedure is carried out in a laminar flow hood (sterile environment). 

1. Add 100 mL DMEM: F-12 media to sterile filtration unit. 

2. Add Heat-inactivated Fetal Bovine Serum, Heat-inactivated Horse Serum, and 

P/S to sterile filtration unit. 

3. Add 111.25 mL DMEM: F-12 media to sterile filtration unit. 

4. Place the lid over sterile filtration unit and connect it to vacuum nozzle. 

5. Carefully turn on the vacuum and allow the liquid to pass through the filter. Make 

sure to hold sterile filtration unit during this step so the unit does not turn over. 

Turn off the vacuum before bubbles form. 

6. Twist top of filtration unit off carefully. Screw sterile cap onto container of 

media. 

7. Label media as Astrocyte media with date and your initials, and store in 

refrigerator. 

A.4 Locke’s Solution 

A.4.1 Materials Required for 250 mL Media 

• 2250 mg of Sodium Chloride (NaCl) (154 mM) 

• 104.4 mg of Potassium Chloride (Kcl) (5.6 mM) 

• 75.6 mg of Sodium Bicarbonate (NaHCO3) (3.6 mM) 

• 84.5 mg of Calcium Chloride (Cacl2.2H2O) (2.3 mM) 

• 252.3 mg of Glucose (5.6 mM) 

• 1.25 mL of 1M stock 4-(2-hydroxyethyle)-2-piperazineethanesulfonic acid 

(HEPES) (pH 7.4) (5 mM) 
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• 248.75 mL purified water 

A.4.2 Preparation of Locke’s Solution 

1.  Dissolve the components in 100 mL of purified water and add to the vacuum 

filtration unit. 

2.  Add 100 mL of purified water to vacuum filtration unit. 

3.  Add water with dissolved components. 

4.  Add 1.25 mL of 1 M stock HEPES. 

5.  Add remaining amount of purified water. 

6.  Place cap on unit. Carefully turn on the vacuum. 

7.  Allow all the liquid to pass through the filter. Turn off the vacuum before bubbles 

form. 

8.  Twist the top of vacuum unit off carefully. Screw the sterile cap onto the 

container of the solution. 

9.  Label as Locke’s solution with date and your initials, and store in refrigerator. 

Note: For preparing Locke’s solution without sodium, replace the Sodium Chloride 

with same molarity of Choline Chloride. There is no any account for Sodium 

Bicarbonate.
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APPENDIX B  
 

FIXING CELLS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



121 

Protocol for fixation is explained in following steps: 

1. Remove complete media from cell culture. 

2. Wash the cells with pre-warmed Locke’s solution. 

3. Add the fixing solution (DiffQuik from Siemens) to cover whole surface of well 

or dish and leave it for 10 minutes. 

4. Remove the fixing solution and add Phosphate Buffer Saline (PBS) to cover 

whole surface. 

5. For storage, label the plate or dish, seal with parafilm and keep it at 2-8 °C (in 

refrigerator). 
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APPENDIX C  
 

GFAP ANTIBODY (AB) STAINING 
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1. Fixation of Cells:  

• Remove complete media from cell culture. 

• Wash twice the cells with pre-warmed Locke’s solution. 

• Add ice-cold methanol to cover whole surface of well or dish and keep it for 5 

minutes. 

• Remove methanol and add 1X PBS to cover whole surface. 

• For storage seal the plate or dish with paraffin and keep it at 2-8 ºC (in refrigerator). 

2. Permeabilization of cells: Remove PBS from pre-fixed cells and 0.2 % Triton X 100 

(in 1X PBS) to cover whole surface and keep it at room temperature for 15 minutes. 

3. Blocking: Remove Triton X 100 and add 2% Goat Serum (in 1X PBS) to cover whole 

surface. Seal the plate or dish with paraffin and keep it at 2-8 ºC (in refrigerator) for 4-

5 hrs or overnight. 

4. Primary Ab: Remove goat serum and add 1° Ab (Anti-GFAP produced in rabbit in 

1:500 1X PBS) to cover the whole surface. Seal the plate or dish with paraffin and keep 

it at 2-8 ºC (in refrigerator) for 24 hrs or overnight. 

5. Washing: Remove 1° Ab and wash twice with 1X PBS. 

6. Secondary Ab: Add 2° Ab (1:500 Goat Anti- Rabbit Ig Ab in 2% Goat Serum which is 

in 1X PBS) to cover the whole surface. Seal the plate or dish with paraffin and cover 

with aluminum foil and keep it at room temperature for 45-60 minutes. 

7. Washing: Remove 2° Ab and wash twice with 0.2 % Triton X 100 (in 1X PBS). Lastly 

add 1X PBS to cover whole surface. 

8. Fluorescence Microscopy: Observe staining using fluorescent microscope. 
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9. Storage: Seal the plate or dish with paraffin and cover with aluminum foil and keep it 

at 2-8 ºC (in refrigerator) for storage for weeks. 
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APPENDIX D  
 

Β-GALACTOSIDASE STAINING 
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D.1.1 Reagents Required for Staining  

• 10X PBS  

 70.2 mM Na2HPO4, 14.7 mM KH2PO4, 1.37 M NaCl, and 26.8 mM KCl 

• 10X Fixation Buffer 

 20% formaldehyde and 2% glutaraldehyde in 10X PBS 

• Reagent A - 200 mM MgCl2 

• Reagent B - 400 mM potassium ferricyanide 

• Reagent C - 400 mM potassium ferrocyanide 

• X-Gal - (5-Bromo-4-chloro-3-indolyl-B-D-galactopyranoside) 

• Dimethylformamide (DMF) 

D.1.2 Preparation Instructions  

• Dilute 10X PBS 10-fold with sterile water to prepare 1X PBS. 

• Dilute 10X Fixation Buffer 10-fold with sterile water to prepare 1X fixation 

solution. 

• Prepare a 20 mg/mL solution of X-Gal in DMF in a polypropylene tube or a glass 

vial. The solution can be stored in the dark at -20 °C for 1 month. 

D.1.3 Procedure for 48-well Cell Culture Plate  

1. Aspirate the growth medium from the cells. 

2. Wash cells twice with 300 uL of 1X PBS. Remove the wash solution entirely with 

aspiration. 

3. Add 300 uL of 1X fixation solution and incubate 10 minutes at room temperature. 

During the fixation process, prepare the staining solution in a polypropylene tube 

as follows: 
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4. Staining Solution 

Component     Amount  

Reagent A     10 uL 

Reagent B     10 uL 

Reagent C     10 uL 

X-Gal solution (20 mg/mL)   50 uL 

1X PBS     920 uL 

Total volume     1 mL (enough for 3 wells) 

5. Rinse the cells twice with 300 uL of 1X PBS. 

6. Add 300 uL of staining solution to the plate. Ensure even coverage of the plate. 

7. Incubate at 37 °C for 0.5-2 hr or longer, until the cells stain blue. In the event a 

longer staining period is needed, seal the plate with parafilm to prevent it from 

drying out. The exact incubation time must be optimized. 

8. Observe the cells under the microscope. Count the cells and calculate the percent 

of stained cells to unstained cells. 

9. For long-term storage of stained plate, remove the staining solution, overlay cells 

with 300 uL 1X PBS and store at 4 °C. 
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APPENDIX E  
 

DAPI STAINING PROTOCOL 
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1. A 14.27 millimolar concentration of DAPI in DI water was diluted 1 to 1000 in 1x PBS.   

2. Once DAPI has been added place dish in 37 ºC incubator for 10 minutes (depending 

on the health of the cells you may need a longer time to load do to the fact that healthy 

cells take longer to load DAPI than damaged or dead cells). 
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APPENDIX F  

 

IMAGE-PRO PLUS VERSION 7.0 
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F.1.1 Calculating the Area of β-gal Staining from the Image 

1. Insert the dongle (special security plug) that comes with Image-Pro Plus to unlock the 

program. 

2. Open Image-Pro Plus 7.0. A dialog box ‘Macro Browser’ appears. Click Done. 

3. Go to File → Open → Select the image. 

4. Go to Measure → Count/Size → Choose ‘Manual’ → Click ‘Select Colors’ → A 

dialog box appears. Click ‘Color Cube Based’ → Select Class ‘1’ → Under Options, 

Select Sensitivity ‘4’ → Pick ‘color picker tool’. Then click on the indigo blue color 

staining (Start selecting the color from lightest to darkest) → Under Preview, select 

‘Current Class’ → Change to ‘Class Color on Black’ from ‘Class Color on Transparent’ 

→ Select ‘Apply Mask’ → Click ‘OK’. 

5. Now choose ‘Automatic Bright Objects’→ Click ‘Count’. The white area gets selected. 

6. Go to ‘Measure’ → Click ‘Select Measurements’ → Choose ‘Area’ → Click 

‘Measure’. 

7. Go to ‘View’ → Click ‘Measurement Data’ → Choose ‘Sort Down’. 

8. Go to ‘File’ → Click ‘Export Data’. This will copy the data into an excel spreadsheet. 
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Figure F.2: An example to import an image to Image Pro-Plus 7.0 to calculate the area of 

β-gal staining. 

 

 

 

Figure F.3: An example to apply mask to the image to calculate the area of β-gal 

staining. 
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Figure F.4: An example to export the data to Excel spreadsheet using Image Pro Plus 

version 7.0. 
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